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はじめに 

 
 

 

Cypress CapSense® ソリューションは、お客様のデザインにエレガントで、信頼性が高く、使い易い静電容量タッチセ

ンシング機能をもたらしています。当社の静電容量タッチセンシング ソリューションは、40 億個以上の機械式ボタンを

置き換えてきました。CapSense により、携帯電話、PC、民生電子機器および大型家電製品のデザインの外観が変わり

ました。サイプレスの堅牢な CapSenseソリューションは、当社のフレキシブルなプログラマブル システム オン チップ 

(PSoC®) アーキテクチャを活用しています。これにより、製品化までの時間を短縮し、重要なシステム機能を統合し、

材料費を削減します。 

概要 

本書では、お客様の実験を支援し、サイプレスの CapSenseコントローラー、CapSenseキット、CapSenseユーザーモ

ジュールの機能を評価するために、10 個の CapSense サンプルコードの概要を記載しています。また、I2C および

UART インターフェースを介してセンサーデータを読み出し、プロットする方法についても説明します。この文書を読む

には、CapSense のセンシング技術を知っている必要があります。CapSense 全般の原理と動作の詳細については、

CapSense入門を参照してください。 

注: 本アプリケーションノートのサンプルコードは、本書で参照するキットに固有のものです。カスタムボードにサンプ

ルコードを移植するには、CapSense 入門で主要な設計留意点やレイアウトのベストプラクティスを参照してください。

本書に、必要なことが書かれていなかった、疑問に対する答がなかった、またはご意見がある場合は、

capsense@cypress.comへ eメールでご連絡ください。 

評価を容易にするために、サンプルコードは簡単なものから複雑なものへ順番に提示します。 

▪ 評価にあたって: 初めての場合、CapSense タッチセンサー機能のデモから開始することをお勧めします。サンプル

コード 1: SmartSense 付きボタン スライダー (CY8C20xx6A CapSense コントローラー) は、SmartSense 自動

チューニング静電容量センサアルゴリズムを使用したタッチボタンやスライダーが、いかに簡単で迅速に実装できる

かを示しています。 

▪ 通信方法: CapSense の仕組みを理解したら、次にデータの送受信を CapSense コントローラーで行う方法を学習し

ます。この通信は、CapSense センサーの調整や、CapSense コントローラーとホストプロセッサをつなぐために必

要です。サンプルコード 2: I2Cによるホスト通信(CY8C20xx6A CapSenseコントローラー使用)およびサンプルコー

ド 3: UARTによるデータ送信 (CY8C20xx6A CapSenseコントローラー使用) では、CapSenseコントローラーで通

信する方法について詳しく説明しています。 

▪ 調整: 次のステップでは、安定した動作のために CapSense センサーを調整します。調整手順を完了するには、まず

PCB 上の静電容量センサーの寄生容量について理解しなければなりません。サンプルコード 4:絶対センサー静電容

量の測定  (CY8C20xx6A CapSense コントローラー使用)、サンプルコード  5: 絶対センサー静電容量の測定 

(CY8C21x34/B CapSense コントローラー使用 )、およびサンプルコード  6: 絶対センサー静電容量の測定 

(CY8C20x34 CapSense コントローラー使用)は、様々な CapSense デバイスの絶対センサー静電容量を測定します。

サンプルコード 7: CSDの調整 (CY8C20xx6A CapSense コントローラー使用)、サンプルコード 8: フィードバック抵抗

付き CSD の調整 (CY8C21x34/B CapSense コントローラー使用)、およびサンプルコード 9: CSA_EMC の調整 

(CY8C20x34 CapSenseコントローラー使用) は、CapSense コントローラーの調整手順について説明します。  

▪ 消費電力に応じて最適化: 最後、サンプルコード 10: CY8C20xx6A の SmartSenseによる CapSenseボタンの消費電

力の最適化では、エンドアプリケーションで電池寿命を伸ばすために、CapSense コントローラーの消費電力を最適

化する方法について説明しています。 

http://www.cypress.com/
http://www.cypress.com/?rID=48787
http://www.cypress.com/?rID=48787
mailto:capsense@cypress.com
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注: この設計ガイドの適用対象は、CY8C20xx6A、CY8C20x34、CY8C21x34/B、および CY8C24x94 の 4 つの

CapSense デバイスです。サンプルコードを他の CapSense デバイスに移植する方法については、本書の付録を参照し

てください。付録では、CSD ユーザーモジュールの設定に関する命令も説明しています。サンプルコードの作成や修正に

は CSDユーザーモジュールの設定が必要です。 

表 1. サンプルコード一覧 

サンプル

コード 
サンプルコード 対象キット 説明 

1 SmartSense付きボタン スライダー 

(CY8C20xx6A CapSenseコントローラー) 

CY3280-20x66 SmartSense自動チューニング ユーザーモジュール付き

CapSenseボタンとスライダーを実装する方法を示す 

2 I2Cによるホスト通信(CY8C20xx6A 

CapSenseコントローラー使用) 

CY3280-20x66 I2Cを介して CapSenseコントローラーへ／から CapSense 

データを転送する方法を示す。また、Bridge Control Panel

ツールを使ってデータをプロットし、読み出す方法を説明 

3 UARTによるデータ送信 (CY8C20xx6A 

CapSenseコントローラー使用) 

CY3280-20x66 RS232データ パケット形式で CapSenseデータを送信する

方法を示す。また、MultiChartツールを使ってデータをプ

ロットし、読み出す方法を説明 

4 絶対センサー静電容量の測定 (CY8C20xx6A 

CapSenseコントローラー使用) 

CY3280-20x66 寄生容量 (CP) が最大 60pFまでのセンサーの絶対静電容量

を 1pF以内の精度で測定して、その結果をWindowsのハイ

パーターミナルあるいはブリッジ コントロール パネルを用

いて PCに表示 

5 絶対センサー静電容量の測定 (CY8C21x34/B 

CapSenseコントローラー使用) 

CY3280-21x34 寄生容量 (CP) が最大 60pFまでのセンサーの絶対静電容量

を 1pF以内の精度で測定して、その結果をウィンドウのハ

イパーターミナルあるいはブリッジ コントロール パネルを

用いて PCに表示する 

6 絶対センサー静電容量の測定 (CY8C20x34 

CapSenseコントローラー使用) 

CY3280-20x34 寄生容量 (CP) が最大 60pFまでのセンサーの絶対静電容量

を 1pF以内の精度で測定 

7 CSDの調整 (CY8C20xx6A CapSense コント

ローラー使用) 

CY3280-20x66 CY8C20xx6Aで CSDユーザーモジュールを調整 

8 フィードバック抵抗付き CSDの調整 

(CY8C21x34/B CapSenseコントローラー使用) 

CY3280-21x34 CY8C21x34/Bで CSDユーザーモジュールを調整 

9 CSA_EMCの調整 (CY8C20x34 CapSenseコ

ントローラー使用) 

CY3280-20x34 CY8C21x34で CSA_EMCユーザーモジュールを調整 

10 CY8C20xx6A の SmartSenseによる

CapSenseボタンの消費電力の最適化 

CY3280-20x66 SmartSenseユーザーモジュールを使用して、センサーの消

費電流を 50µA未満にする方法を説明 

表 2. 製品ファミリ別サンプルコード 

 製品ファミリ 

機能 CY8C20xx6A CY8C20x34 CY8C21x34/B CY8C24x94 

SmartSense付きボタン スライダー サンプルコード 1 N/A[1] 要移植[2] N/A[1] 

I2Cとホスト通信 I2C サンプルコード 2 要移植[2] 要移植[2] 要移植[2] 

UART によるデータの送信 サンプルコード 3 要移植[2] 要移植[2] 要移植[2] 

絶対センサー静電容量測定 サンプルコード 4 サンプルコード 5 サンプルコード 6 要移植[2] 

CSDの調整 サンプルコード 7 N/A[3] 無 N/A[3] 

                                                      

1 これらのデバイスは、SmartSense UMに対応していません。 
2 サンプルコードは、「他のCapSenseデバイスへのサンプルコードの移行 

」セクションで説明するように、このガイドで提供されるプロジェクトが付録の各デバイスへ移植された後に作動します。 
3 調整手法は、このデバイスとユーザーモジュールに固有です。 

http://www.cypress.com/
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 製品ファミリ 

機能 CY8C20xx6A CY8C20x34 CY8C21x34/B CY8C24x94 

フィードバック抵抗付き CSDの調整 N/A[3] N/A[3] サンプルコード 8 N/A[3] 

CSA_EMCの調整 N/A[3] サンプルコード 9 N/A[3] N/A[3] 

SmartSenseで消費電力の最適化 サンプルコード 10 無 無 無 

 

http://www.cypress.com/
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サンプルコード 1 SmartSense付きボタン 

スライダー (CY8C20xx6A CapSenseコント

ローラー) 

 
 

 

1.1   プロジェクト名 

CE_1_ButtonsandSliders_withSmartSense_withCY8C20xx6A 

1.2   概要 

静電容量センサーを適切に動作させるには、寄生容量 (CP) に応じていくつかのパラメーターを手動で調整する必要があ

ります。SmartSense™ユーザ モジュールは、CSD UMの基本アーキテクチャを改善、拡張します。主要な機能の 1つは、

SmartSense自動チューニングです。SmartSenseのユーザーモジュールは、各センサーの CPに基づき、実行中に寄生容

量の動作パラメーターを最適化します。SmartSense を使用する際に、手動で調整する必要はありません。このサンプル

コードは、SmartSense ユーザーモジュールの使用方法を示します。EzI2C ユーザーモジュールを使用して、CapSense®

パラメーター (raw カウント、差分カウント、各ボタンのベースライン、スライダのセントロイド位置など) を I2C マス

ターに送信します。 

1.3   ハードウェアのセットアップ 

1.3.1   要求事項 

▪ CY3280-20x66 Universal CapSense Controller board 

▪ CY3280-SLM Universal CapSense Linear Slider Module 

▪ CY3240-I2USB Bridgeまたは CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1 Programmer Kitまたは CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bのケーブル 

▪ Windows XP以降のオペレーティング システムを実行する PC 

1.3.2   組み立て 

図 1-1 ハードウェアの準備を示します。CY3280-20x66 UCCキットを CY3280-SLMモジュールに 22x2_RA_Receptacle

経由で接続します。MiniProg1/MiniProg3または I2USBブリッジ/MiniProg3を使って、キットの ISSPヘッダーに接続し

ます。ハードウェア準備では、プログラミングに MiniProg1/MiniProg3を使用し、PCにデータを送信するには I2USBブ

リッジ/Miniprog3を使用します。これらは、USBケーブルで PCに接続します。 

http://www.cypress.com/
http://www.cypress.com/?rID=38222
http://www.cypress.com/?rID=37761
http://www.cypress.com/?rID=3421
http://www.cypress.com/?rID=38154
http://www.cypress.com/?rID=37459
http://www.cypress.com/?rID=38154
http://www.cypress.com/?rID=38222
http://www.cypress.com/?rID=37761
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図 1-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-20x66 UCC

MiniProg1/MiniProg3

I2USB / MiniProg3

PC

 

1.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLMドーター カードのヘッダーJ1を CY3280-20x66 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの VCC ピンと VCC_PROGピンを接続させます。この設定により、ISSP

コネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン (ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチ パターンが接地されます。 

▪ MiniProg1/MiniProg3 を UCC ボードの J3 上の ISSP ヘッダーに接続します。この接続は、コードで生成される hex

ファイルで UCCをプログラミングする時のみ要求されます。この接続は、CapSenseデータが Bridge Control Panel

ソフトウェアで読み出される時、I2USBブリッジ/MiniProg3と置き換える必要があります。 

▪ USB A－ミニ Bケーブルを使用して、MiniProg1 (または I2USBブリッジまたはMiniProg3) 他方の端を PCに接続し

ます。 

http://www.cypress.com/
http://www.cypress.com/?rID=37761
http://www.cypress.com/?rID=38222


 SmartSense付きボタン スライダー (CY8C20xx6A CapSenseコントローラー) 

www.cypress.com  文書番号: 001-85884 Rev. *C 13 

1.4   回路図 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nF のコンデンサです。560Ω の抵抗は、RF 干渉を軽減するため、 

各 CapSense ボタンに直列に接続されます。LED は 1kΩ の直列抵抗に接続しアクティブローの設定です。全部で、LED

が 5個、ボタンが 5個、セグメントが 10あるスライダが 1個あります。 

表 1-1. LED、ボタン、スライダー セグメントのピン割り当て 

LED ボタン スライダー セグメント 

LED0 - P2[5] BTN0 - P1[6] SLD0 - P1[4]、SLD1 - P0[6] 

LED1 - P2[7] BTN1 - P1[3] SLD2 - P0[4]、SLD3 - P0[2] 

LED2 - P0[1] BTN2 - P3[3] SLD4 - P2[6]、SLD5 - P2[4] 

LED3 - P0[5] BTN3 - P2[1] SLD6 - P2[2]、SLD7 - P2[0] 

LED4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]、SLD9 - P3[0] 

1.5   ソフトウェアの準備 

1.5.1   ツール 

▪ PSoC Designer™ (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル)  

 

CY8C20666 

http://www.cypress.com/
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1.5.2   ユーザーモジュール リスト 

以下の表は、このサンプルコードで使用されるユーザーモジュール (UM)、および各 UMが占有するハードウェア リソー

スを一覧にします。 

ユーザーモジュール ハードウェア リソース 

SmartSense CapSense とコンパレータ、タイマー 1 

EzI2Cs I2C/SPIブロック 

1.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバル リソースのリストが含まれています。 

1.6   動作 

リセットすると、ファームウェアは以下の動作を実行します。 

▪ 構造体 MyI2C_Regsを定義してボタン番号、rawカウント、差分カウント、ベースライン、セントロイド位置、所定

のボタン番号に対応する CapSenseボタンの状態を保管します。 

▪ グローバル割り込みを有効にしてから、SmartSenseユーザーモジュールを開始します。 

▪ EzI2Cs UMを開始し、構造体MyI2C_Regsを I2C RAMバッファとして設定します。 

▪ 無限ループで以下の操作を実行します。 

 すべてのセンサーを継続的にスキャンし、構造体 MyI2C_Regsを rawカウント、差分カウント、ベースライン、

スライダのセントロイド位置、および要求される CapSense ボタンで更新します。I2C マスターは、ボタン番号

を EzI2Cスレーブの I2Cバッファの最初のバイトに書き込み、特定のボタンの CapSenseを要求することができ

ます。 

 ファームウェアはボタンが押されるのを検出すると、対応する LED を点灯させます。ボタンを放すと、LED を

消灯させます。 

 スライダーに触れると、ファームウェアは LEDを点灯させて接触位置を示します。 

http://www.cypress.com/


 SmartSense付きボタン スライダー (CY8C20xx6A CapSenseコントローラー) 

www.cypress.com  文書番号: 001-85884 Rev. *C 15 

図 1-2. サンプルコード 1の機能フローチャート 
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1.7   サンプルコードの実行 

ボードにサンプル プロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-20x66キット ガイドの第 5章を参照してください。 

1. ボードを 5V で給電するには、MiniProg1/MiniProg3 または CY3280-20x66 UCC キットガイドで説明している電源の 

いずれかを使用します。 

2. CY3280-SLMモジュール ボードでリニア スライダーに触れます。CY3280-SLMモジュール ボードの対応する LED

が点灯します。 

3. ボタンに触れます。CY3280-SLM モジュール ボードの対応する LEDが点灯します。同時に複数のボタンが機能しま

す。リニア スライダーとボタンも同時に使用できます。 

1.8   I2Cを経由した CapSenseデータの読み出し 

この手順を使用してサンプルコードを実行し、CapSenseデータを Bridge Control Panelツールで読み出します。Bridge 

Control Panelツールの詳細については、「AN2397、“CapSense® Data Viewing Tools」を参照してください。 

1.8.1   Bridge Control Panelツールの起動 

1. I2USBブリッジ/MiniProg3と USB A－ミニ Bケーブルを併用して、コンピューターを CY3280-20x66ユニバーサル

CapSenseコントロール ボードの ISSPコネクタ J3に接続します。 

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

Bridge Control Panelは、PSoC Programmerのインストール中にインストールされるコンポーネントです。 

3. ポート選択ウィンドウからデバイスを選択します。 

4. CY3280-20X66 CapSenseコントローラー ボードに 5Vで電力を供給します。 

5. Bridge Control Panel で File > Open を選択します。サンプルコード プロジェクト フォルダに含まれる「BCP 

Configuration Files」フォルダから BCP.iic ファイルを読み出します。  

http://www.cypress.com/
http://www.cypress.com/?docID=29621
http://www.cypress.com/?docID=29621
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6. Charts > Variable Settingsを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP Configuration 

Files」フォルダから BCP.ini ファイルを読み出します。  

 

7. OKをクリックして、メイン画面に戻ります。 

1.8.2   BTN0の rawカウント、ベースライン、差分カウントの読み出し 

1. I2Cの書き込み命令W 04 00 00を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1Diffcount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、BTN0の rawカウント、ベースライン、差分カウントを表示します。 

1.8.3   SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションの読

み出し 

1. I2C書き込み命令W 04 00 05を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1Diffcount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションを表示し

ます。 
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サンプルコード 2 I2Cによるホスト通信

(CY8C20xx6A CapSenseコントローラー使用) 

 
 

 

2.1   プロジェクト名 

CE_2_HostCommunication_viaI2C_withCY8C20xx6A 

2.2   概要 

このサンプルコードでは、I2C 通信プロトコルを使用して、5 個の CapSense®ボタンと 10 個のセグメントを持つスライ

ダーのデータ (rawカウント、差分カウント、ベースライン、ステータス) を Bridge Control Panelツールに送信すると、

そこでデータが表示されます。CSD アルゴリズムは、CY8C20xx6A CapSense コントローラー上のボタンを実践します。

ボタン番号を指定すると、その特定のボタンのデータを取得できます。 

2.3   ハードウェアのセットアップ 

2.3.1   要求事項 

▪ CY3280-20x66ユニバーサル CapSenseコントローラー ボード  

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ CY3240-I2USBブリッジまたは CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1プログラマ キット または CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

2.3.2   アセンブリ 

図 2-1 は、ハードウェアの準備を示します。 CY3280-20x66 UCC キットを CY3280-SLM モジュールに

2x2_RA_Receptacle 経由で接続します。MiniProg1/MiniProg3 または I2USB ブリッジ/MiniProg3 をキットの ISSP ヘッ

ダーに接続します。ハードウェア準備では、プログラミングに MiniProg1/MiniProg3 を使用し、PC にデータを送信する

には I2USBブリッジ/MiniProg3を使用します。これらは、USBケーブルで PCに接続します。 

図 2-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-20x66 UCC

MiniProg1/MiniProg3

I2USB / MiniProg3

PC
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2.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLMドーターカードのヘッダーJ1を CY3280-20x66 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの VCC ピンと VCC_PROGピンを接続させます。この設定により、ISSP

コネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン (ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンが接地されます。 

▪ MiniProg1/MiniProg3 を UCC ボードの J3 上の ISSP ヘッダーに接続します。この接続は、コードで生成される hex

ファイルで UCCをプログラミングする時のみ要求されます。この接続は、CapSenseデータが Bridge Control Panel

ソフトウェアで読み出される時、I2USBブリッジ/MiniProg3と置き換える必要があります。 

▪ USB A－ミニ Bケーブルを使用して、MiniProg1 (または I2USBブリッジまたはMiniProg3) 他方の端を PCに接続し

ます。 

2.4   回路図 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nF のコンデンサです。560Ω の抵抗は、RF 干渉を軽減するため、 

各 CapSenseボタンに直列に接続されます。LEDは 1kΩの直列抵抗に接続しアクティブ ローの設定です。全部で、LED

が 5個、ボタンが 5個、セグメントが 10あるスライダーが 1個あります。 

表 2-1. LED、ボタン、スライダー セグメントのピン割り当て 

LED ボタン スライダー セグメント 

LED0 - P2[5] BTN0 - P1[6] SLD0 - P1[4]、SLD1 - P0[6] 

LED1 - P2[7] BTN1 - P1[3] SLD2 - P0[4]、SLD3 - P0[2] 
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LED2 - P0[1] BTN2 - P3[3] SLD4 - P2[6]、SLD5 - P2[4] 

LED3 - P0[5] BTN3 - P2[1] SLD6 - P2[2]、SLD7 - P2[0] 

LED4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]、SLD9 - P3[0] 

 

2.5   ソフトウェアの準備 

2.5.1   ツール 

▪ PSoC Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル)  

2.5.2   ユーザーモジュール リスト 

以下の表は、このサンプルコードで使用されるユーザーモジュール (UM)、および各 UMが占有するハードウェア リソー

スを一覧にします。 

ユーザーモジュール ハードウェア リソース 

CSD CapSenseブロック、タイマー1 (デフォルト) 

EzI2C I2C/SPI ブロック 

2.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバルリソースのリストが含まれています。 

注: サンプルコードは、CY3280-SLM キットに付属するアクリル製オーバーレイ (1.5mm) 向けに調整しました。オー

バーレイがこれより厚い場合は、サンプルコード 7: CSDの調整 (CY8C20xx6A CapSense コントローラー使用)で説明している

プロジェクトを調整します。 

2.6   動作 

リセットすると、ファームウェアは以下の動作を実行します。 

▪ 構造体 MyI2C_Regsを定義してボタン番号、rawカウント、差分カウント、ベースライン、セントロイド位置、所定

のボタン番号に対応する CapSenseボタンの状態を保管します。 

▪ グローバル割り込みを有効にしてから、CSDのユーザーモジュールを開始します。 

▪ EzI2Cのユーザーモジュールを開始し、構造体 MyI2C_Regsを I2C RAMバッファとして設定します。 

▪ 無限ループで以下の操作を実行します。 

 すべてのセンサーを継続的にスキャンし、構造体 MyI2C_Regsを rawカウント、差分カウント、ベースライン、

スライダーのセントロイド位置、および要求される CapSense ボタンで更新します。I2C マスターは、ボタン番

号を EzI2C スレーブの I2C バッファの最初のバイトに書き込んで、特定のボタンの CapSenseデータを要求する

ことができます。 

 ファームウェアはボタンが押されるのを検出すると、対応する LED を点灯させます。ボタンを放すと、LED を

消灯させます。 

 スライダーに触れると、ファームウェアは LEDを点灯させて接触位置を示します。 
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図 2-2. サンプルコード 2の機能フローチャート 
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2.7   サンプルコードの実行 

ボードにサンプル プロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-20x66キット ガイドの第 5章を参照してください。 

1. ボードを 5Vで給電するには、MiniProg1/Miniprog3または CY3280-20x66 UCCキットガイドで説明している電源のい

ずれかを使用します。 

2. CY3280-SLMモジュール ボードでリニア スライダーに触れます。 

CY3280-SLMモジュール ボードの対応する LEDが点灯します。 

3. ボタンに触れます。  

CY3280-SLM モジュール ボードの対応する LED が点灯します。同時に複数のボタンが機能します。リニア スライ

ダーとボタンも同時に使用できます。 

2.8   I2Cを経由した CapSenseデータの読み出し 

この手順を使用してサンプルコードを実行し、CapSenseデータを Bridge Control Panelツールで読み出します。Bridge 

Control Panelツールの詳細については、「AN2397、“CapSense® Data Viewing Tools」を参照してください。 

2.8.1   Bridge Control Panelの起動 

1. I2USBブリッジ/MiniProg3と USB A－ミニ Bケーブルを併用して、コンピューターを CY3280-20x66ユニバーサル

CapSenseコントロール ボードの ISSPコネクタ J3に接続します。 

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

Bridge Control Panelは、PSoC Programmerのインストール中にインストールされるコンポーネントです。 

3. ポート選択ウィンドウからデバイスを選択します。 

4. CY3280-20X66 CapSenseコントローラー ボードに 5Vで電力を供給します。 

5. Bridge Control Panel で File > Open を選択します。サンプルコード プロジェクトフォルダに含まれる「BCP 

Configuration Files」フォルダから BCP.iic ファイルを読み出します。 
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6. Charts > Variable Settingsを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP Configuration 

Files」フォルダから BCP.iic ファイルを読み出します。  

 

7. OKをクリックして、メイン画面に戻ります。 

2.8.2   BTN0の rawカウント、ベースライン、差分カウントの読み出し 

1. I2Cの書き込み命令W 04 00 00を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、BTN0の rawカウント、ベースライン、差分カウントを表示します。 

2.8.3   SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションの読

み出し 

1. I2C書き込み命令W 04 00 05を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションを表示し

ます。 

http://www.cypress.com/


 

www.cypress.com  文書番号: 001-85884 Rev. *C 22 

サンプルコード 3 UARTによるデータ送信 

(CY8C20xx6A CapSenseコントローラー使用) 

 
 

 

3.1   プロジェクト名 

CE_3_DataTransmission_viaUART_withCY8C20xx6A 

3.2   概要 

このサンプルコードでは、UART 通信プロトコルを使用して、CapSense®データを MultiChart ツールが読み出せる形式

で PC に送信します。MultiChart ツールは、raw カウント、差分カウント (信号)、ベースライン、およびスライダの位置

の CapSense パラメーターをグラフ形式で表示するのに使用します。SmartSense™ ユーザーモジュール (UM) は、

CY3280-SLMですべてのボタンとスライダー セグメントを継続的にスキャンし、UART UMは CapSenseパラメーター

を TX8 出力ピンに送信します。外部レベル トランスレータは、TX8 データを RS232 レベルに変換してから、標準

RS232ケーブルで PCに送信します。PCでは、MultiChartツール (AN2397で紹介) を使用してデータを監視します。こ

のサンプルコードは、CY3280-SLM の LED のオンとオフを切り替えて、ボタンのステータスやスライダーの位置を示し

ます。 

3.3   ハードウェアの準備 

3.3.1   要求事項 

▪ CY3280-20x66ユニバーサル CapSenseコントローラー ボード  

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ CY3217-MiniProg1プログラマ キット または CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

▪ 外部 RS232レベル トランスレータ 

▪ 標準 9ピン RS232のシリアル ケーブル 

▪ シリアル ポート (9ピン RS232) 搭載 PC 

3.3.2   アセンブリ 

図 3-1ハードウェアの準備を示します。CY3280-20x66 UCCキットを CY3280-SLMモジュールに 22x2_RA_Receptacle

経由で接続します。MiniProg1/MiniProg3 をヘッダーJ3 に接続してから、キットをプログラミングし、電力を供給します。

コネクタ P3の P3[5]は、外部レベル トランスレータに接続してから UARTケーブル経由で PCに接続します。 
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図 3-1. ハードウェア セットアップのブロック図 

USB  

RS232 Serial 
PortRS232  CY3280-20x66 

UCC  

UART to 
USB Bridge 

 

MultiChart  

RS232 Level 
Translator  

 
 

 

注: CY3280-20x66 UCCは、UART －USBブリッジまたは RS232レベル トランスレータ (RS232シリアル ポート搭載

の PCが必要) のいずれかの方法で PCにデータを送信します。 

3.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLMドーターカードのヘッダーJ1を CY3280-20x66 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの VCC ピンと VCC_PROGピンを接続させます。この設定により、ISSP

コネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン (ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンが接地されます。 

▪ MiniProg1/ MiniProg3を J3ヘッダー上の CY3280-20x66 UCCに接続します。 

▪ CY3280-20x66 UCC上のコネクタ P3のコネクタ P3[5]を外部レベル トランスレータに接続します。サンプルの回路

図については、図 3-2を参照してください。 

▪ CY3280-20x66 UCC上のコネクタ P3から GNDを外部レベル トランスレータに接続します。 

▪ 外部レベル トランスレータに電力を供給します。CY3280-20x66上のコネクタ P3から VCCを使用して、外部レベル

の返還装置に 5Vの電力を供給します。 

▪ RS232ケーブルを外部レベル トランスレータの出力から PCに接続させます。  
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3.4   回路図 

 

 

図 3-2. 外部レベル トランスレータ 
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変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nF のコンデンサです。560Ω の抵抗は、RF 干渉を軽減するため、 

各 CapSense ボタンに直列に接続されます。LED は 1kΩ の直列抵抗に接続しアクティブローの設定です。全部で、LED

が 5個、ボタンが 5個、セグメントが 10あるスライダーが 1個あります。 

表 3-1. LED、ボタン、スライダー セグメントのピン割り当て 

LED ボタン スライダー セグメント 

LED0 - P2[5] BTN0 - P1[6] SLD0 - P1[4]、SLD1 - P0[6] 

LED1 - P2[7] BTN1 - P1[3] SLD2 - P0[4]、SLD3 - P0[2] 

LED2 - P0[1] BTN2 - P3[3] SLD4 - P2[6]、SLD5 - P2[4] 

LED3 - P0[5] BTN3 - P2[1] SLD6 - P2[2]、SLD7 - P2[0] 

LED4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]、SLD9 - P3[0] 

3.5   ソフトウェアの準備 

3.5.1   ツール 

▪ PSoC Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ MultiChartツール (AN2397で紹介) 

3.5.2   ユーザーモジュールの一覧 

以下の表は、このサンプルコードで使用されるユーザーモジュール (UM)、および各 UMが占有するハードウェア リソー

スを列挙しています。 

ユーザーモジュール ハードウェア リソース 

SmartSense CapSenseブロック、タイマー1 (デフォルト) 

UART 占有するブロックなし (ソフトウェア実装) 

3.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバル リソースのリストが含まれています。 

3.6   動作 

リセットすると、プログラムはデバイス コンフィギュレーションからデバイスにすべてのハードウェア設定を読み出し、

main.cを実行します。ファームウェアは以下の動作を実行します。 

▪ グローバル割り込みを有効にしてから、SmartSenseと UARTユーザーモジュールを開始します。 

▪ センサー ベースラインを初期化します。 

▪ 無限ループで以下の操作を実行します。 

 すべてのセンサーを継続的にスキャンし、UART ユーザーモジュールを使用して raw カウント、差分カウント、

ベースライン、およびスライダーの位置を TX8ピンに送信します。 

 ファームウェアはボタンが押されるのを検出すると、対応する LED を点灯させます。ボタンを放すと、LED を

消灯させます。 

 スライダーに触れると、ファームウェアは LEDを点灯させて接触位置を示します。 

http://www.cypress.com/
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図 3-3. サンプルコード 3の機能フローチャート 
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3.7   コード サンプルの実行 

ボードにサンプルプロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-20x66キット ガイドの第 5章を参照してください。 

1. ボードを 5Vで給電するには、MiniProg1/ MiniProg3または CY3280-20x66 UCC キットガイドで説明している電源の

いずれかを使用します。 

2. CY3280-SLMモジュール ボードでリニア スライダーに触れます。 

CY3280-SLMモジュール ボードの対応する LEDが点灯します。 

3. ボタンに触れます。 

CY3280-SLM モジュール ボードの対応する LED が点灯します。同時に複数のボタンが機能します。リニア スライ

ダーとボタンも同時に使用できます。 
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3.8   CapSenseデータを MultiChartでプロットする 

この手順を使用してサンプルコードを実行し、MultiChart ツールをプロットしたデータを表示します。MultiChart ツール

の詳細について、およびこのツールをダウンロードするには、 「AN2397, “CapSense® Data Viewing Tools”」を参照し

てください。 

1. MultiChartツールを開きます。 

2. MultiChartツールで、Tools > Settingsを選択します。 

設定ダイアログ ボックスが表示されます。 

 

3. Select port ドロップリストを使用して、ボードをコンピュータに接続するのに使用する COM ポートを選択します。  

ほとんどの場合、COM1 経由で接続します。ただし、御使用のシステムはこれとは異なるかもしれません。 

4. Port speedドロップリストで 115200を選択してから、OKをクリックします。 

rawカウントが赤で、ベースラインがブルーで表示されます。 

 

5. ボタン 0に触れて、信号を観察します (差分カウント)。 
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6. シリアル 15の「raw count 15」変数は下記のようにスライダーの位置 (0～100) を示します。観察できない場合、拡

大したり、Chart > Edit...>Axisで軸を自動に設定したりします。 

 

7. センサービューでは、一度に 1 台のみセンサーが表示されます。この場合、「Raw Count 15」はスライダーの位置

を示します。複数のセンサーを観察するには、「Custom View」タブをクリックします。 

 

http://www.cypress.com/
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サンプルコード 4 絶対センサー静電容量の

測定 (CY8C20xx6A CapSenseコントローラー

使用) 

 
 

 

4.1   プロジェクト名 

CE_4_MeasuringAbsSensorCap_withCY8C20xx6A 

4.2   概要 

このサンプルコードでは、CY8C20xx6A CapSense®コントローラーを使用して、5 個のセンサーの絶対静電容量を計算

し、Windowsのハイパー ターミナル ソフトウェアまたはブリッジ コントロール パネルを搭載したコンピューターで結

果を表示する方法を示します。絶対静電容量は 1pF単位で測定されます。 

4.3   ハードウェアの準備 

4.3.1   要求事項 

▪ CY3280-20x66ユニバーサル CapSense コントローラー 

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ RS232レベル トランスレータ モジュール  

▪ CY3240-I2USBブリッジまたは CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1プログラマ キット または CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bのケーブル 

▪ Windows XP以降のオペレーティング システムを実行する PC 

4.3.2   アセンブリ 

下図はハードウェアの準備を示します。CY3280-20x66 UCCキットを CY3280-SLMモジュールに 22x2_RA_Receptacle

経由で接続します。MiniProg1/MiniProg3 をヘッダーJ3 に接続してから、キットをプログラミングし、電力を供給します。 
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図 4-1. ハードウェア セットアップのブロック図 
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Level Translator
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注: このサンプルコードは、外部レベル トランスレータを使用します。ただし、UART－USB ブリッジを使用して、PC

でデータを表示することも可能です。UCCキットに含まれる CY3240-I2USBブリッジを UART－USBブリッジに変換す

ることができます。詳細については、「AN2397, “CapSense® Data Viewing Tools”」を参照してください。ブリッジ コ

ントロール パネル ソフトウェアは、I2C-USBブリッジまたは MiniProg3を介して PCのセンサーの Cpを表示するため

に使用されます。ハイパーターミナルは RS232通信プロトコルで PCのデータを表示するために使用されます。  

4.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLMドーターカードのヘッダーJ1を CY3280-20x66 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの VCC ピンと VCC_PROGピンを接続させます。この設定により、ISSP

コネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン(ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンがグランド接続されます。 

▪ MiniProg1/MiniProg3を J3ヘッダー上の CY3280-20x66 UCCに接続します。 

▪ センサーの Cpが I2C通信プロトコルによってブリッジ コントロール パネルで表示される場合、CY3280-20x66Aの

ジャンパ J3を I2C-USBブリッジ/MiniProg3に、および USB A ～ ミニ Bケーブルによってブリッジ/MiniProg3の残

りの端をコンピュータに接続させます。ブリッジ コントロール パネルの電源切り替えボタンをクリックしてデバイ

スに電源を供給します。 

▪ センサーCp が UART によりハイパーターミナルで表示される場合、RS232 レベル トランスレータ ボード上の TX 

ピンを UCCの P1[7]に接続させます。レベル トランスレータの Vccピンと GNDピンを、UCCの Vccピンと GND

ピンにそれぞれ接続します。RS232レベル トランスレータの好例は、MAX232シリアル レベル コンバータです。 

▪ シリアル ケーブルを使用して、レベル トランスレータ ボードの RS232ポートをコンピューターに接続します。 
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4.4   回路図 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nFのコンデンサです。560Ωの抵抗は、RF干渉を軽減するため、各

CapSenseボタンに直列に接続されます。 

表 4-1. CapSenseボタンのピンの割り当て 

ボタン ピン 

0 P1[6] 

1 P1[3] 

2 P3[3] 

3 P2[1] 

4 P2[3] 

 

4.5   ソフトウェアの準備 

4.5.1   ツール 

▪ PSoC® Designer™ (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル) 

▪ Windows ハイパーターミナル 
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4.5.2   ユーザーモジュール 

以下の表は、このサンプルコードで使用されるユーザーモジュール(UM)、および各ユーザーモジュールが占有するハー

ドウェア リソースを一覧にします。 

ユーザー 

モジュール 
ハードウェア リソース 

CSD CapSenseブロック、タイマー1 (デフォルト) 

EzI2C I2Cブロック 

TX8SW 占有するブロックなし (ソフトウェア実装) 

4.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバル リソースのリストが含まれています。 

4.6   動作 

このプログラムでは、センサーの rawカウントの計算に以下の公式を使用します。 

 

ここでは、 

n = 分解能 

Vref = リファレンス電圧 

fs = プリチャージ クロックのスイッチング電圧 

Cs = センサー静電容量 

iDAC = iDAC電流 

n、fおよび Vrefは CSD UMパラメーターで確定できます。 

iDACは以下の式で確定できます。 

 

IDAC_Dは制御レジスタの設定であり、iDACrangeは CSD UMパラメーター設定での「Idac範囲」です。これら両方の

値は設計時に既知の値です。IDACを計算するために必要な唯一の欠けている部分は iDACgainです。iDACgainはデバイ

スによって PVT と共に変化する A/ビットの単位での iDAC 強度です。4X 範囲では、iDACgain のテスト限界は 230nA/

ビット < iDACgain < 270nA/ビットです。 

クリプトン ATEプログラム (量産中) は、IDAC_D = 0xC0 = 192で 4x範囲内で iDAC電流を測定します。公称 247nA/

ビット iDACの場合、この電流は 247nA/ビットになります；192 * 4 = 190uA。ATEは実際の電流を測定し、190uAとの

差を uA の単位および符号と絶対値のフォーマットで記録し、それを bIDACComp として格納します。最上位ビット 

(MSB) (マスク = 0x80) は符号を表すビットとして解釈され、その値が「1」の場合、 負の値を表し、「0」の場合、「正

の値」を表します。例えば、0x8Dが格納されたデバイスの場合、iDACgain = (190uA – 13uA) / (4 * 192) = 230nA/ビット

となります。  

注: 

感度= Cs/Rawカウント = 
(2𝑛−1) ∗ 𝑉𝑟𝑒𝑓 ∗ 𝑓𝑠 

𝑖𝐷𝐴𝐶
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このプログラムでは、以下の手順を使用して画面に絶対静電容量を表示します。 

1. センサーの感度を計算し、可変感度で結果を保管します。GetIDACComp() は、GetIDACComp.asm ファイルで定義

されたカスタム機能で、IDACで部分ごとのばらつきの IDAC補正を取得します。 

2. 注: IDACは温度のばらつきにより変動するため、このサンプルコードは室温でのみ有効です。 

3. グローバル割り込みを有効にしてから、ユーザーモジュールを開始します。 

4. 各センサーを順番にスキャンし、配列 CSD_waSnsResult[] から rawカウントを取得します。 

5. rawカウントと感度の比率を取得して、絶対静電容量を計算します。 

6. ユーザーの選択に応じてブリッジ コントロール パネルまたはハイパーターミナルを表示するために結果をコン

ピュータに送信します。 

図 4-2. サンプルコード 4のフローチャット 
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4.7   サンプルコードの実行  

UCC基板のプログラミング 

#define UARTステートメントが以下のスクリーンショットに示されるようにmain.cでコメントアウトされます。その後、

プロジェクトを生成し (F6 を押す)、ボードをプログラムします。UCC ボードのプログラミングの方法については、

CY3280-20x66キット ガイドの第 5章を参照してください。 

 

BCPによるセンサー データの観察 

1. CY3280-20x66Aのジャンパ J3を I2C-USBブリッジ/MiniProg3に、および USB A～ミニ Bケーブルによって I2C-

USB ブリッジ/MiniProg3の残りの端をコンピューターに接続させます。  

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

3. ポート選択ウィンドウからデバイス (I2C-USBブリッジまたはMiniProg3) を選択します。  

4. ブリッジ コントロール パネルのトグルパワー ボタンをクリックしてデバイスに電源を供給します。 

5. Bridge Control Panelツールで File > Openを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP 

Configuration Files」フォルダから BCP.iniファイルを読み出します。  

6. Charts > Variable Settingsを選択します。プロジェクト フォルダに含まれる「BCP Configuration Files」フォルダ

から BCP.iniファイルを読み出します。 

7. 送信ボタンをクリックして、I2C コマンドを CY8C20xx6 コントローラーに送信して、下図に示すように最下部のウ

インドウのセンサーCp値を 16進法で取得します。 

 

 

 

センサーCp (16進数) 
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UCC基板のプログラミング 

以下のスクリーンショットに示すように#define UART ステートメントに対してコメントを削除して、プロジェクトを生

成し、UCCボードをプログラムします。 

    

 

ハイパーターミナルによるセンサー データの観察 

1. Miniprog1 あるいは Miniprog3を使ってボードに電源を供給します。  

2. コンピューターのデスクトップで、Start > All Programs > Accessories > Communication > HyperTerminalを選

択します。  

3. 接続名を入力します。  

4. OKをクリックします。 

センサーCp (10進数) 
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5. 「Connect using」 ドロップリストを使用して PSoC からのデータ受信に使用されるシリアル ポートを選択します。  

6. OKをクリックします。 

 

7. 「COM Properties」ダイアログ ボックスでは、以下のパラメーターを設定してください。  

▪ Bits per second = 115200  

▪ Data bits = 8  

▪ Parity = None  

▪ Stop bits = 1  

▪ Flow control = None  

 

8. OK をクリックします。ハイパーターミナルは、指定された COM ポートに接続されており、使える状態にあります。  

http://www.cypress.com/
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9. UCCの電源をオンにしてから、リセットします。  

 

結果がハイパーターミナルのウィンドウに表示されます。 

http://www.cypress.com/
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サンプルコード 5 絶対センサー静電容量の

測定 (CY8C21x34/B CapSenseコントローラー

使用) 

 
 

 

5.1   プロジェクト名 

CE_5_MeasuringAbsSensorCap_withCY8C21x34 

5.2   概要 

このサンプルコードでは、CY8C21x34/B CapSense®コントローラーを使用して、5 個のセンサーの絶対静電容量を計算

し、Windowsのハイパー ターミナル ソフトウェアまたはブリッジ コントロール パネルを搭載したコンピューターで結

果を表示する方法を示します。絶対静電容量は 1pF単位で測定されます。  

5.3   ハードウェアの準備 

5.3.1   要求事項 

▪ CY3280-21x34ユニバーサル CapSenseコントローラー 

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ RS232レベル トランスレータ モジュール  

▪ CY3240-I2USBブリッジ または CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1 Programmer または CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

▪ Windows XP以降のオペレーティング システムを実行する PC 

5.3.2   アセンブリ 

図  5-1 は、ハードウェアの準備を示します。 CY3280-21x34 UCC キットを CY3280-SLM モジュールに

22x2_RA_Receptacle 経由で接続します。MiniProg1/MiniProg3 をヘッダーJ3 に接続してから、キットをプログラミング

し、電力を供給します。 

ブリッジ コントロール パネル ソフトウェアは、I2C-USBブリッジまたは MiniProg3で PCのセンサーCpを表示するた

めに使用されます。 

ハイパーターミナルは RS232通信プロトコルで PCのデータを表示するために使用されます。 

http://www.cypress.com/
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図 5-1. ハードウェア準備のブロック図 

CY3280SLM CY3280-21x34 UCC

MiniProg1/MiniProg3

I2USB / MiniProg3/RS232 

Level Translator

PC

 

5.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLM ドーターカードのヘッダーJ1 を CY3280-21x34UCC ボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ1 にジャンパーを嵌め、UCC ボードの VCCピンと 5 V を接続させます。この設定により、ISSP コネクタ

から CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン (ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンがグランド接続されます。 

▪ MiniProg1/MiniProg3を J3ヘッダー上の CY3280-21x34 UCCに接続します。 

▪ センサーCpが I2C通信プロトコルによってブリッジ コントロール パネルで表示される場合、CY3280-21x34のジャ

ンパ J3を I2C-USBブリッジ/MiniProg3に、および USB A ～ ミニ Bケーブルによってブリッジの残りの端をコン

ピューターに接続させます。ブリッジ コントロール パネルのトグルパワー ボタンをクリックしてデバイスに電源を

供給します。 

▪ センサーCp が UART によりハイパーターミナルで表示される場合、RS232 レベル トランスレータ ボード上の TX 

ピンを UCCの P1[7]に接続させます。レベル トランスレータの Vccピンと GNDピンを、UCCの Vccピンと GND

ピンにそれぞれ接続します。RS232レベル トランスレータの好例は、MAX232シリアル レベル コンバータです。 

▪ シリアル ケーブルを使用して、レベル トランスレータ ボードの RS232ポートをコンピューターに接続します。 

 

http://www.cypress.com/
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5.4   回路図 

 

表 5-1.サンプルコード 5のピン割り当て 

対象 ピン 

ボタン 0 P1[6] 

ボタン 1 P1[3] 

ボタン 2 P3[3] 

ボタン 3 P2[1] 

CMOD P0[3] 

Rb P3[1] 

5.5   ソフトウェアの準備 

5.5.1   ツール 

▪ PSoC® Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル)  

▪ Windowsハイパーターミナル 
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5.5.2   ユーザーモジュール 

以下の表は、このサンプルコードで使用されるユーザーモジュール(UM)、および各 UM が占有するハードウェア リソー

スを一覧にします。 

ユーザー  

モジュール 
ハードウェア リソース 

CSD CapSenseブロック、タイマー1 (デフォルト) 

EzI2C I2Cブロック 

TX8SW 占有するブロックなし (ソフトウェア実装) 

 

5.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバル リソースのリストが含まれています。 

5.6   動作 

このプログラムでは、センサーの rawカウントの計算に以下の公式を使用します。 

Raw Counts = CP . Sensitivity 

ここでは、CPは、センサー静電容量です。 

このように、このプログラムでは、rawカウントと感度の比率を取得して、各センサーの絶対静電容量を計算します。 

このプロジェクトには、CY8C21x34/B_CalculSensitivity.xls というファイルが含まれています。このファイル

には、感度の計算式が含まれています。最も正確な結果を生じた基準値とプリスケーラのパラメーターの設定は、 

▪ Ref Value = 5 

▪ Prescaler = 5 

このプログラムでは、以下の手順を使用して画面に絶対静電容量を表示します。 

1. この設定では、計算された感度は 465 カウント/pF と等しくなります。CY8C21x34/B_CalculSensitivity.xls ファイル

を参照してください。 

.xlsファイルはこのプロジェクトの一部であり、プロジェクト フォルダに保管されています。 

2. グローバル割り込みを有効にしてから、ユーザーモジュールを開始します。 

3. 各センサーを順番にスキャンし、配列 CSD_waSnsResult[] から rawカウントを取得します。 

4. rawカウントと感度の比率を取得して、絶対静電容量を計算します。 

5. ユーザーの選択に応じてブリッジ コントロール パネルまたはハイパーターミナルを表示するために結果をコン

ピューターに送信します。 

 

http://www.cypress.com/
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図 5-2. サンプルコード 5の機能フローチャート 

Start

Enable global interrupts

Start CSD UM

Loop forever

Scan Sensor

Calculate sensor absolute 

capacitance

Display capacitance value in 

Hyperterminal/Bridge Control 

Panell 

Yes No

Next sensor

Initialize Sensor scan loop

UART Enabled?

Start EzI2C UM

Start TX8SW UM

Yes

No

All Sensors Complete

Initialize baselines, Set Finger 

Threshold

Call DisplayMessage()
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5.7   コードの実行 

基板のプログラミング 

以下のスクリーンショットに示すようにmain.c内の#define UARTステートメントがコメントアウトされたことを確保し、

プロジェクトを生成し、UCC ボードをプログラムします。UCC ボードのプログラミングの方法については、CY3280-

21x34キット ガイドの第 5章を参照してください。 

 

BCPによるセンサー データの観察 

1. CY3280-21x34のジャンパ J3を I2C-USBブリッジ/MiniProg3に、および USB A ～ ミニ Bケーブルによって

I2C-USB ブリッジ/MiniProg3の残りの端をコンピューターに接続させます。  

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番

号) > Bridge Control Panel (バージョン番号) を選択します。 

3. ポート選択ウィンドウからデバイスを選択します。  

4. CY3280-21X34 UCCキット ボードに 5Vで電力を供給します。  

5. Bridge Control Panelツールで File > Openを選択します。サンプルコード プロジェクト フォルダに含まれる

「BCP Configuration Files」フォルダから BCP.iniファイルを読み出します。  

6. Charts > Variable Settingsを選択します。プロジェクト フォルダに含まれる「BCP Configuration Files」フォ

ルダから BCP.iniファイルを読み出します。 

7. 送信ボタンをクリックして、I2Cコマンドを CY8C21x34コントローラーに送信して、下のスクリーンショット

に示すように最下部のウインドウのセンサーCP値を 16進法で取得します。 

 

 

センサーCp (16進数) 

http://www.cypress.com/
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ボードのプログラミング 

main.c内の#define UARTステートメントに対してコメントを解除し、ボードをプログラムします。 

 

HyperTerminal を使ってセンサー データを監視します。  

1. Miniprog1 あるいは Miniprog3を使ってボードに電源を供給します。  

2. コンピューターのデスクトップで、Start > All Programs > Accessories > Communication > HyperTerminalを選

択します。  

3. 接続名を入力します。  

4. OKボタンをクリックします。 

センサーCp（10進数） 

http://www.cypress.com/
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5. 「Connect using」ドロップリストを使用して、SoCからデータを受領するのに使用するシリアル ポートを選択

します。この設定は、PCのコンフィギュレーションにより異なります。この例では、COM5を使用します。 

6. 「OK」をクリックします。 

 

 

 

7. COM Propertiesダイアログボックスでは、以下のパラメーターを設定します。 

 Bits per second = 115200 

 Data bits = 8 

 Parity = None 

 Stop bits = 1 

 Flow control = None 

8. OKをクリックします。 

ハイパーターミナルは、指定された COMポートに接続されており、使える状態にあります。 

http://www.cypress.com/
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9. UCCの電源をオンにしてから、リセットします。  

結果がハイパーターミナルのウィンドウに表示されます。 

 

 

http://www.cypress.com/
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サンプルコード 6 絶対センサー静電容量の

測定 (CY8C20x34 CapSenseコントローラー

使用) 

 
 

 

6.1   プロジェクト名 

CE_6_MeasuringAbsSensorCap_withCY8C20x34 

6.2   概要 

このサンプルコードは、CY3280-20x34 CapSense®コントローラーを使用して 5 個のセンサーの絶対静電容量を計算し

ます。絶対静電容量は 1pF単位で測定されます。 

6.3   ハードウェアの準備 

6.3.1   要求事項 

▪ CY3280-20x34ユニバーサル CapSenseコントローラー  

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ CY3217 – MiniProg1 Programmer または CY8CKIT-002 Miniprog3 

▪ CY3240 – I2USBブリッジ または CY8CKIT-002 Miniprog3 

▪ USB A－ミニ B ケーブル 

▪ Windows XP以降のオペレーティング システムを実行する PC 

▪ マルチメーター 

6.3.2   組み立て 

図 6-1 は、ハードウェアの準備を示します。 CY3280-20x34 UCC キットを CY3280-SLM モジュールに

22x2_RA_Receptacle 経由で接続します。MiniProg1/Miniprog3 をヘッダーJ3 に接続してから、キットをプログラミング

し、電力を供給します。 

http://www.cypress.com/
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図 6-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-20x34 UCC

MiniProg1/MiniProg3

CY3240 I2USB/MiniProg3 

PC

 

6.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLM ドーターカードのヘッダーJ1 を CY3280-20x34UCC ボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ1 にジャンパーを嵌め、UCC ボードの VCCピンと 5 V を接続させます。この設定により、ISSP コネクタ

から CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン(ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンがグランド接続されます。 

▪ MiniProg1/Minirpog3 を UCC ボードの J3 上の ISSP ヘッダーに接続します。この接続は、コードで生成される hex

ファイルで UCC をプログラミングするときのみ要求されます。この接続は、CapSense データが Bridge Control 

Panelソフトウェアで読み出される時、I2USBブリッジと置き換える必要があります。 

▪ USB A－ミニ Bケーブルを使用して、MiniProg1/Miniprog3 (または I2USBブリッジ) の他の端を PCに接続します。 

http://www.cypress.com/
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6.4   回路図 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 3.9nFのコンデンサです。560Ωの抵抗は、RF干渉を軽減するため、各

CapSenseボタンに直列に接続されます。 

表 6-1. サンプルコード 6のピン割り当て 

ボタン ピン 

0 P1[6] 

1 P1[3] 

2 P3[3] 

3 P2[1] 

4 P2[3] 

CY8C20434 
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6.5   ソフトウェアの準備 

6.5.1   ツール 

▪ PSoC® Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル) 

6.5.2   ユーザーモジュール 

以下の表は、このサンプルコードで使用されるユーザーモジュール(UM)、および各 UM が占有するハードウェア リソー

スを一覧にします。 

ユーザーモジュール ハードウェア リソース 

CSA_EMC CapSenseブロック、コンパレータ (デフォルト) 

EzI2Cs I2C/SPI 

6.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバル リソースのリストが含まれています。  

6.6   動作 

main.cファイルには、2つの機能があります。1つは各センサーの IDACコードを計算する機能です。もう 1つは、IDAC

電流を直接測定できるポート ピンに対応の電流を駆動します。各センサーの絶対静電容量は、以下の方程式で計算しま

す。 

CP =  
Imeasured

(IMO
8⁄ ) ×  1.3

 

ここでは、CPはセンサー静電容量です。 

プログラムは、以下の手順で処理します。 

▪ 2つの関数 calc_IDACおよび source_IDACを定義してから、ユーザー入力に応じてどちらかを呼び出します。 

▪ 最初の関数 calc_IDACは、以下の動作を実行します。 

 配列 baIDACを定義し、センサー番号に従って各 CapSenseセンサーの IDACコードを保管します。 

 配列を I2C読み出しバッファとして設定します。 

 グローバル割り込みを有効にしてから、ユーザーモジュールを起動します。 

 無限ループで、各センサーを順番にスキャンし、配列に保管されている IDACコードを取得します。I2C バッファ

も更新します。 

▪ 2つ目の関数 source_IDACは、以下の動作を実行します。 

 ポートピン P1[4]を High-Zドライブ設定の出力として設定します。 

 ピン P1[4]を内部アナログMUXバスに接続します。 

 入力された IDACコードを読み出します。 

 ピン P1[4]に対応する電流を供給します。 

http://www.cypress.com/
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図 6-2. サンプルコード 6の機能フローチャート 
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6.7   サンプルコードの実行 

ボードにサンプルプロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC 基板の

プログラミングの方法については、CY3280-20x34キット ガイドの第 5章を参照してください。 

1. I2USBブリッジと USB A－ミニ Bケーブルを使用して、コンピュータを CY3280-20x34ユニバーサル CapSenseコ

ントローラー ボードの ISSPコネクタ J3に接続させます。 

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

Bridge Control Panelツールは、PSoC Programmerのインストール コンポーネントの 1つです。 

3. ポート選択ウィンドウからデバイスを選択します。 

4. CY3280-20X34 CapSenseコントローラー ボードに 5Vで電力を供給します。 

5. Bridge Control Panel ツールで、 Tools > Protocol Configuration を選択します。I2C タブで、I2C Speed を

100kHzに設定します。 

6. File > Openを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP Configuration Files」フォルダ

から BCP.iic ファイルを読み出します。 

http://www.cypress.com/
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図 6-3. ステータス ウィンドウでスレーブ アドレスを表示 

 

7. [Enter] を押して、Bridge Control Panelの 2番目の指示を実行します。  

ステータス ウィンドウに、センサー全部の IDACコードが表示されます。 

8. 5個のセンサーの IDACコードが表示されたら、プロジェクトを開き、ステートメント source_IDAC(),を非コメント

化し、ステートメント calc_IDAC()をコメント化して、ポートピン P1[4]に対応する電流を供給します。 

9. 関数 source_IDAC()で、適切な 16 進数を IDAC_D 変数に割り当てて、IDAC コードをいずれかのセンサーの Bridge 

Control Panelで取得したセンサーに設定します。 

10. PSoC Designer を 使 用 し て 、 こ の プ ロ ジ ェ ク ト を ビ ル ド し ま す 。  Build > Generate ま た は 

CE_6_MeasuringAbsSensorCap_withCY8C20x34 を選択します。ビルド中にエラーまたは警告が表示されないこ

とを確認します。 

11. 生成された hexファイルで UCCをプログラミングするには、Program > Program Partを選択します。 

12. Program Part ウィンドウで、MiniProg1/Miniprog3 が接続されていることを確認します。接続されていない場合は、

Connectボタンをクリックします。 

13. Programボタンをクリックします。 

14. UCCから CY3280-ボードの接続を切断します。 

15. パワー ボタンをクリックして、MiniProg1/Miniprog3から UCCに電力を供給します。 

16. ピンとグランドの間に電流計を挿入し、P1[4]から流れる電流 (IMEASURED) を測定します。 

17. 計算式を使用して、CPを計算します。 

CP =  
Imeasured

(IMO
8⁄ ) ×  1.3

  

ここで、IMOは、システム クロック ソースです。このプロジェクトでは、12MHzに設定します。 

18. ステップ 9から 17までを繰り返して、他のセンサーの CPを取得します。 

表 6-2では、CapSenseセンサーの CP値の他に、Bridge Control Panelを介して取得した IDACコード、およびピンで供

給される IDAC電流が一覧にします。 

http://www.cypress.com/


 絶対センサー静電容量の測定 (CY8C20x34 CapSenseコントローラー使用) 

www.cypress.com  文書番号: 001-85884 Rev. *C 53 

表 6-2. 測定 CP 

CapSense 

センサー 
IDAC コード 

ポートピン (µA) 

に供給される IDAC電流 
CP測定値 (pF) 

P1[6] 0A 28.0 14.40 

P1[3] 09 25.3 12.98 

P3[3] 08 22.6 11.58 

P2[1] 07 19.3 9.90 

P2[3] 07 19.3 9.90 
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サンプルコード 7 CSDの調整 (CY8C20xx6A 

CapSense コントローラー使用) 

 
 

 

7.1   プロジェクト名 

CE_7_TuningCSD_withCY8C20xx6A 

7.2   概要 

このサンプルコードでは、CY8C20xx6A デバイスの CapSense®を調整する方法を示しています。CapSense UM を調整

するには、CapSense データをグラフ形式で表示できなければなりません。このサンプルコードでは、EzI2C UM を使用

して必要な CapSenseパラメーターを I2Cバスと I2USBブリッジに転送します。PCで Bridge Control Panelを使用して、

このデータを表示します。 

7.3   ハードウェアのセットアップ 

7.3.1   要求事項 

▪ CY3280-20x66ユニバーサル CapSenseコントローラー ボード  

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ CY3240-I2USBブリッジまたは CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1プログラマ キットまたは CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

▪ Windows XP以降のオペレーティング システムを実行する PC 

7.3.2   組み立て 

図 7-1 は、ハードウェアの準備を示します。 CY3280-20x66 UCC キットを CY3280-SLM モジュールに

22x2_RA_Receptacle経由で接続します。MiniProg1/MiniProg3または I2USBブリッジ/MiniProg3をキットの ISSPヘッ

ダーに接続します。ハードウェア準備では、プログラミングに MiniProg1/MiniProg3 を使用し、PC にデータを送信する

には I2USBブリッジ/Miniprog3を使用します。これらは、USBケーブルで PCに接続します。 

図 7-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-20x66 UCC

MiniProg1/MiniProg3

CY3240 I2USB/MiniProg3 

PC
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7.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLMドーターカードのヘッダーJ1を CY3280-20x66 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの VCC ピンと VCC_PROG ピンを接続させます。この設定により、

ISSPコネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン(ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンがグランド接続されます。 

▪ MiniProg1/Miniprog3 を UCC ボードの J3 上の ISSP ヘッダーに接続します。この接続は、コードで生成される hex 

ファイルで UCC をプログラミングするときのみ要求されます。この接続は、CapSense データが Bridge Control 

Panelソフトウェアで読み出される時、I2USBブリッジと置き換える必要があります。 

▪ USB A－ミニ Bケーブルを使用して、MiniProg1/Miniprog3 (または I2USBブリッジ) の他の端を接続します。 

7.4   回路図 

 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nF のコンデンサです。560Ω の抵抗は、RF 干渉を軽減するため、 

各 CapSense ボタンに直列に接続されます。LED は 1kΩ の直列抵抗に接続しアクティブローの設定です。全部で、LED

が 5個、ボタンが 5個、セグメントが 10あるスライダーが 1個あります。 

表 7-1. LED、ボタン、スライダー セグメントのピン割り当て 

LED ボタン スライダー セグメント 

LED0 - P2[5] BTN0 - P1[6] SLD0 - P1[4]、SLD1 - P0[6] 

CY8C20666 

http://www.cypress.com/
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LED1 - P2[7] BTN1 - P1[3] SLD2 - P0[4]、SLD3 - P0[2] 

LED2 - P0[1] BTN2 - P3[3] SLD4 - P2[6]、SLD5 - P2[4] 

LED3 - P0[5] BTN3 - P2[1] SLD6 - P2[2]、SLD7 - P2[0] 

LED4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]、SLD9 - P3[0] 

7.5   ソフトウェアの準備 

7.5.1   ツール 

▪ PSoC® Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.14以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル) 

7.5.2   ユーザーモジュールと配置 

以下の表は、このコード表で使用されているユーザーモジュール 、および各ユーザーモジュールが占有するハードウェ

ア リソースを一覧にします。 

ユーザーモジュー

ル 
配置 

CSD CapSenseブロック、タイマー1 (デフォルト) 

EzI2C I2C/SPIブロック 

7.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバルリソースのリストが含まれています。 

注: サンプルコードは、 CY3280-SLM キットに付属するアクリル製オーバーレイ (1.5mm) 向けに調整しました。オー

バーレイがこれより厚い場合は、このサンプルコードで説明しているプロジェクトを調整します。 

7.6   動作 

リセットすると、ファームウェアは以下の動作を実行します。 

▪ 構造体 MyI2C_Regsを定義してボタン番号、rawカウント、差分カウント、ベースライン、セントロイド位置、所定

のボタン番号に対応する CapSenseボタンの状態を保管します。 

▪ グローバル割り込みを有効にしてから、CSDのユーザーモジュールを開始します。 

▪ EzI2Cs UMを開始し、構造体MyI2C_Regsを I2C RAMバッファとして設定します。 

▪ 無限ループで以下の操作を実行します。 

 すべてのセンサーを継続的にスキャンし、構造体 MyI2C_Regsを rawカウント、差分カウント、ベースライン、

スライダーのセントロイド位置、および要求される CapSense ボタンで更新します。I2C マスターは、ボタン番

号を EzI2Cスレーブの I2Cバッファの最初のバイトに書き込み、特定のボタンの CapSenseを要求することがで

きます。 

 ファームウェアはボタンが押されるのを検出すると、対応する LED を点灯させます。ボタンを放すと、LED を

消灯させます。 

 スライダーに触れると、ファームウェアは LEDを点灯させて接触位置を示します。 

http://www.cypress.com/
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図 7-2. サンプルコード 7の機能的フローチャート 
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7.7   コードの実行 

ボードにサンプル プロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-20x66キット ガイドの第 5章を参照してください。 

1. ボードを 5Vで給電するには、MiniProg1/Miniprog3または CY3280-20x66 UCC キットガイドで説明している電源の 

いずれかを使用します。 

2. CY3280-SLMモジュール ボードでリニア スライダーに触れます。 

CY3280-SLMモジュール ボードの対応する LEDが点灯します。 

3. ボタンに触れます。 

CY3280-SLM モジュール ボードの対応する LED が点灯します。同時に複数のボタンが機能します。リニア スライ

ダーとボタンも同時に使用できます。 

7.8   I2Cを経由した CapSenseデータの読み出し 

この手順を使用してサンプルコードを実行し、CapSenseデータを Bridge Control Panelツールで読み出します。Bridge 

Control Panelツールの詳細については、「AN2397、“CapSense® Data Viewing Tools」を参照してください。 
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7.8.1   Bridge Control Panelツールの起動 

1. I2USBブリッジ/ MiniProg3と USB A－ミニ Bケーブルを使用して、コンピューターを CY3280-20x66の ISSPコネ

クタ J3に接続します。 

2. コンピューターのデスクトップで、 Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

Bridge Control Panelは、PSoC Programmerのインストール中にインストールされるコンポーネントです。 

3. ポート選択ウィンドウからデバイスを選択します。 

4. CY3280-20X66 CapSenseコントローラー ボードに 5Vで電力を供給します。 

5. Bridge Control Panel で File > Open を選択します。サンプルコード プロジェクト フォルダに含まれる「BCP 

Configuration Files」フォルダから BCP.iic ファイルを読み出します。 

6. Charts > Variable Settingsを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP Configuration 

Files」フォルダから BCP.ini ファイルを読み出します。OKをクリックして、メイン画面に戻ります。 

図 7-3. Bridge Control Panelの表示 

 

 

7.8.2   BTN0の rawカウント、ベースライン、差分カウントの読み出し 

1. I2Cの書き込み命令W 04 00 00を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、BTN0の rawカウント、ベースライン、差分カウントを表示します。 

http://www.cypress.com/
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7.8.3   SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションの読

み出し 

1. I2C書き込み命令W 04 00 05を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションを表示し

ます。 

7.9   CSDユーザーモジュールの調整 

このセクションでは、以下のフローチャートで概説されている手順を用いて、ユーザーモジュール パラメーターを調整

します。詳細については、CY8C20xx6A CapSense Design Guideを参照してください。 

http://www.cypress.com/
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図 7-4. CSDユーザーモジュールを調整するためのフローチャート 
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Reset to 10

End

Hardware 

Parameters
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Parameters

 

7.9.1   CSDユーザーモジュールの設定を行う 

PSoC Designerツールを使用して、CSDユーザーモジュール パラメーター設定を以下のように入力します。 

1. シールド電極は必要ありません。したがって、ShieldElectrodeOutパラメーターを Noneに設定します。 

2. 表 7-2では、サンプルコード 3: 絶対センサー静電容量の測定 (CY8C20xx6A CapSenseコントローラー使用)で示さ

れるメソッドを使用するセンサーCPを一覧にします。すべてのセンサーの CPは 45pF 未満であるため、IDAC 範囲

を 4Xに設定します。 
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表 7-2. すべてのセンサーの CP 

センサー番号 ピン CP 

BTN0 P1[6] 16pF 

BTN1 P1[3] 14pF 

BTN2 P3[3] 13pF 

BTN3 P2[1] 12pF 

BTN4 P2[3] 11pF 

SLD0 P1[4] 14pF 

SLD1 P0[6] 15pF 

SLD2 P0[4] 14pF 

SLD3 P0[2] 14pF 

SLD4 P2[6] 13pF 

SLD5 P2[4] 12pF 

SLD6 P2[2] 12pF 

SLD7 P2[0] 12pF 

SLD8 P3[2] 11pF 

SLD9 P3[0] 11pF 

 

3. AutoCalibrationパラメーターを有効にします。 

4. プリチャージソースを PRSにセットします。 

PRSソースはスペクトル拡散により、外部ノイズ源に対するイミュニティを確実にします。 

5. すべてのセンサーのうちで最も高い CPに従ってプリスケーラを設定します。この例の最大 CPは 16pFであるため、

プリスケーラーを 4に設定します。 

詳細については、CSDユーザーモジュール データシートにある「Prescaler Setting Based on Precharge Source, IMO, 

and CP」表を参照ください。 

6. プロジェクトに異なる CP を持つ複数のセンサーが含まれる場合、最大の CP を持つセンサーに従って分解能を設定

し ま す 。 

この例では、最大の CPは 16pF、Cf は 0.2pF より大きくなります。「CSD ユーザーモジュール データシート」内の

「Finger Capacitance（CF） Based on Overlay Thickness and Circular Sensor Diameter」図および「Resolution 

Setting Based on Finger Capacitance and CP」表を参照して、分解能を 13に設定してください。 

7. Scan速度を Fastにセットします。 

8. スキャン時間は、380µs より大きくなります。「Scan Time for a Single Sensor in μs Based on Resolution and 

Scanning Speed」表 (CSD ユーザーモジュール データシートに収録) を参照して、スキャン時間を 720μs、PRS 

Resolutionを 8ビットに設定します。 

9. 表 7-3では、Bridge Control Panelで観察される、異なるセンサーのノイズ (指を触れない時の Rawカウントのばら

つき) および信号 (指を触れる時の応答) の値を列挙しています。  

表 7-3. 全センサーの信号 

センサー番号 平均指を触れない時の rawカウント ノイズ  信号 SNR (整数に丸めた値) 

BTN0 7072 24 260 11 

BTN1 7017 22 280 13 

BTN2 7103 24 280 12 

BTN3 7275 22 340 15 

BTN4 6953 20 360 18 
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センサー番号 平均指を触れない時の rawカウント ノイズ  信号 SNR (整数に丸めた値) 

SLD0 6627 26 165 6 

SLD1 7071 24 150 6 

SLD2 6697 24 150 6 

SLD3 6505 24 145 6 

SLD4 6028 22 160 7 

SLD5 5840 28 155 5 

SLD6 5687 26 160 6 

SLD7 5598 24 150 6 

SLD8 5362 24 150 6 

SLD9 5110 30 160 5 

 

10. 全センサーの SNRが 5:1を超え、スキャン時間は指で押すと LEDが瞬間的に光る程度に短いため、表 7-4で説明し

ているようにしきい値のパラメーターを設定することができます。  

閾値を設定するには、全センサーの中で最も低い信号の値を基準として使用します。したがって、この例では、信号

の値は 145です。 

表 7-4. CSD UMの高級パラメーター 

閾値パラメーター 推奨値 値 UMパラメーター設定 

指の閾値 信号の 75% 108.75 108 

ノイズ閾値 信号の 40% 58 58 

ベースライン更新閾値 2*ノイズ閾値 116 116 

マイナスのノイズ閾値 ノイズ閾値 58 58 

ヒステリシス 信号の 15% 21.75 21 

 

11. スキャン時間の要件を満たしており、誤検出がレポートされていないので、Low Baseline Resetパラメーターを 10

にセットします。Debounceを 3にセットします。 
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サンプルコード 8 フィードバック抵抗付き

CSDの調整 (CY8C21x34/B CapSenseコント

ローラー使用) 

 
 

 

8.1   プロジェクト名 

CE_8_TuningCSD_withCY8C21x34/B 

8.2   概要 

このサンプルコードでは、CY8C21x34/B デバイスの CSD ユーザーモジュール (UM) を調整する方法を示します。

CapSense ユーザーモジュールをチューニングするには、CapSense データをグラフ形式で表示できなければなりません。 

このサンプルコードでは、EzI2C UM を使用して必要な CapSense パラメーターを I2C バスと I2USB ブリッジに転送し

ます。PCで Bridge Control Panelを使用して、このデータを表示します。 

8.3   ハードウェアのセットアップ 

8.3.1   要求事項 

▪ CY3280-21x34ユニバーサル CapSenseコントローラー ボード  

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ CY3240-I2USBブリッジまたは CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1プログラマ キットまたは CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

▪ Windows XP以降の OSを実行する PC 

8.3.2   アセンブリ 

図 8-1 は、ハードウェアのセットアップを示します。CY3280-21x34 UCC キットを CY3280-SLM モジュールに

22x2_RA_Receptacle 経由で接続します。MiniProg1/Miniprog3 または I2USB ブリッジのどちらかを、キットの ISSP

ヘッダーに接続します。ハードウェア準備では、プログラミングに MiniProg1/Miniprog3 を使用し、PC にデータを送信

するには I2USBブリッジ/Miniprog3を使用します。 これらは、USBケーブルで PCに接続します。  
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図 8-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-21x34 UCC

MiniProg1/MiniProg3

CY3240 I2USB/MiniProg3 

PC

 

8.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLMドーターカードのヘッダーJ1を CY3280-21x34 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの 5V ピンと VCC_PROG のピンを接続させます。この設定により、

ISSPコネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン(ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチ パターンが接地されます。 

▪ MiniProg1/MiniProg3 を UCC ボードの J3 上の ISSP ヘッダーに接続します。この接続は、コードで生成される hex

ファイルで UCC をプログラミングするときのみ要求されます。この接続は、CapSense データが Bridge Control 

Panelソフトウェアで読み出される時、I2USBブリッジ/Miniprog3 と置き換える必要があります。 

▪ USB A－ミニ Bケーブルを使用して、MiniProg1 (または I2USBブリッジ、あるいはMiniProg3) の他方の端に接続し

ます。 
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8.4   回路図 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nF のコンデンサです。560Ω の抵抗は、RF 干渉を軽減するため、 

各 CapSense ボタンに直列に接続されます。LED は 1kΩ の直列抵抗に接続しアクティブローの設定です。全部で、LED

が 5個、ボタンが 5個、セグメントが 10あるスライダーが 1個あります。 

表 8-1. LED、ボタン、スライダー セグメントのピン割り当て 

LED ボタン スライダー セグメント 

LED0 - P2[5] BTN0 - P1[6] SLD0 - P1[4]、SLD1 - P0[6] 

LED1 - P2[7] BTN1 - P1[3] SLD2 - P0[4]、SLD3 - P0[2] 

LED2 - P0[1] BTN2 - P3[3] SLD4 - P2[6]、SLD5 - P2[4] 

LED3 - P0[5] BTN3 - P2[1] SLD6 - P2[2]、SLD7 - P2[0] 

LED4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]、SLD9 - P3[0] 

8.5   ソフトウェアの準備 

8.5.1   ツール 

▪ PSoC® Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジコントロールパネル) 
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8.5.2   ユーザーモジュールと配置 

以下の表は、このコード表で使用されているユーザーモジュール 、および各ユーザーモジュールが占有するハードウェ

ア リソースを一覧にします。 

ユーザーモジュー

ル 
配置 

CSD CapSenseブロック、タイマー1 (デフォルト) 

EzI2C I2C/SPIブロック 

8.5.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバルリソースのリストが含まれています。 

注: サンプルコードは、 CY3280-SLM キットに付属するアクリル製オーバーレイ (1.5mm) 向けに調整しました。オー

バーレイがこれより厚い場合は、このサンプルコードで説明しているプロジェクトを調整します。 

8.6   動作 

リセットすると、ファームウェアは以下の動作を実行します。 

▪ 構造体 MyI2C_Regsを定義し、ボタン番号、rawカウント、差分カウント、ベースライン、セントロイド位置、所定

のボタン番号に対応する CapSenseボタンのステータスを保管します。 

▪ グローバル割り込みを有効にしてから、CSDユーザーモジュールを開始します。 

▪ EzI2C UMを開始し、構造体MyI2C_Regsを I2C RAMバッファとして設定します。  

▪ 無限ループで以下の操作を実行します。 

 すべてのセンサーを継続的にスキャンし、構造体 MyI2C_Regsを rawカウント、差分カウント、ベースライン、

スライダのセントロイド位置、および要求される CapSense ボタンで更新します。I2C マスターは、ボタン番号

を EzI2Cスレーブの I2Cバッファの最初のバイトに書き込み、特定のボタンの CapSenseを要求することができ

ます。 

 ファームウェアはボタンが押されるのを検出すると、対応する LED を点灯させます。ボタンを放すと、LED を

消灯させます。 

 スライダーに触れると、ファームウェアは LEDを点灯させて接触位置を示します。 
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図 8-2. サンプルコード 8の機能フローチャート 
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A. Initialize CapSense 
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thresholds

Loop Forever

Scan All Sensors

Update all baselines

Check for active 

sensors

Update LEDs

Update I2C RAM buffer with 

CapSense parameters

(RawCount, Baseline, SensorMask, 

Difference Counts, Slider Position)

 

 

8.7   コードの実行 

ボードにサンプル プロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-21x34キットガイドの第 5章を参照してください。 

1. ボードを 5Vで給電するには、MiniProg1/Miniprog3または CY3280-21x34 UCCキットガイドで説明している電源のい

ずれかを使用します。 

2. CY3280-SLMモジュール ボードでリニア スライダーに触れます。  

CY3280-SLMモジュール ボードの対応する LEDが点灯します。 

3. ボタンに触れます。  

CY3280-SLM モジュール ボードの対応する LED が点灯します。同時に複数のボタンが機能します。リニア スライ

ダーとボタンも同時に使用できます。 

8.8   I2Cを経由した CapSenseデータの読み出し 

この手順を使用してサンプルコードを実行し、CapSenseデータを Bridge Control Panelツールで読み出します。Bridge 

Control Panelツールの詳細については、「AN2397、“CapSense® Data Viewing Tools」を参照してください。  

8.8.1   Bridge Control Panelツールの起動 

1. I2USBブリッジ/MiniProg3と USB A－ミニ Bケーブルを使用して、コンピューターを CY3280-21x34ユニバーサル

CapSenseコントロール ボードの ISSPコネクタ J3に接続します。 

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

Bridge Control Panelは、PSoC Programmerのインストール中にインストールされるコンポーネントです。 

3. ポート選択ウィンドウからデバイスを選択します。 

4. CY3280-21X34 CapSenseコントローラー ボードに 5Vで電力を供給します。 
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5. Bridge Control Panel で File > Open を選択します。サンプルコード プロジェクト フォルダに含まれる「BCP 

Configuration Files」フォルダから BCP.iic ファイルを読み出します。 

6. Charts > Variable Settingsを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP Configuration 

Files」のフォルダから BCP.ini ファイルを読み出します。OKをクリックして、メイン画面に戻ります。 

 

 

8.8.2   BTN0の rawカウント、ベースライン、差分カウントの読み出し 

1. I2Cの書き込み命令W 04 00 00を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、BTN0の rawカウント、ベースライン、差分カウントを表示します。 

8.8.3   SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションの読

み出し 

1. I2C書き込み命令W 04 00 05を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、SLD0の rawカウント、ベースライン、差分カウント、スライダ ポジションを表示しま

す。 
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8.9   CSDユーザーモジュールの調整 

このセクションでは、以下のフローチャートで概説されている手順を用いて、ユーザーモジュールパラメーターを調整し

ます。詳細については、CY8C21x34/B CapSense design guideを参照してください。 

Begin

Setup Hardware and Software

Water Tolerance Required

Shield Electrode Out = Enabled

Route shield electrode to pin

Reference = ASE11

Ref Value = 2

Select Prescaler if using a 

configuration with prescaler

Raw Counts = 60-70% Max

Increasing Rb increaces 

Raw Count

Increasing Resolution and 

decreasing Scan Speed 

increases SNR

Set High-Level Parameters

End

No

Yes

No

Yes

No SNR > 5

Yes

 

 

8.9.1   CSD UMの設定を行う 

PSoC Designerツールを使用して、CSD UMパラメーター設定を以下のように入力します。 

1. このサンプルコードは、Rb = 15kΩおよび CMOD = 10nFを使用します。CY3280-21x34 UCCボードは、固定抵抗 Rb

を伴います。カスタムボード デザインについては、Rbを調整してユーザーモジュールを調整します。  

CapSense センサーの適切な感度を得るために Rb の最適値を選択する方法については、CY8C21x34/B CapSense 

design Guideのセクション 4.2.3を参照してください。 

2. シールド電極は必要ありません。したがって、ShieldElectrodeOutパラメーターを Noneに設定します。 
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表 8-2では、サンプルコード 5: 絶対センサー静電容量の測定 (CY8C21x34/B CapSenseコントローラー使用) で示

されるメソッドを使用して測定した各センサーの CPを一覧にします。この例の最大 CP は 16pF であるため、プリ

スケーラを 4に設定します。 

表 8-2. 全てのセンサーの CP 

センサー ピン CP 

BTN0 P1[6] 16pF 

BTN1 P1[3] 14pF 

BTN2 P3[3] 13pF 

BTN3 P2[1] 12pF 

BTN4 P2[3] 11pF 

SLD0 P1[4] 14pF 

SLD1 P0[6] 15pF 

SLD2 P0[4] 14pF 

SLD3 P0[2] 14pF 

SLD4 P2[6] 13pF 

SLD5 P2[4] 12pF 

SLD6 P2[2] 12pF 

SLD7 P2[0] 12pF 

SLD8 P3[2] 11pF 

SLD9 P3[0] 11pF 

 

3. プリチャージソースを PRSに設定します。  

PRSソースはスペクトル拡散により、外部ノイズ源に対するイミュニティを確実にします。 

4. すべてのセンサーのうちで最も高い CPに従ってプリスケーラを設定します。この例の最大 CPは 16pFであるため、

プリスケーラを 4に設定します。 

詳細については、CSD UMデータシートにある「Prescaler Setting Based on Precharge Source, IMO, and CP」表を

参照ください。 

5. プロジェクトに異なる CP を持つ複数のセンサーが含まれる場合、最大の CP を持つセンサーに従って分解能を設定

します。この例では、最大の CPは 16pF、Cfは 0.2pFより大きくなります。「CSD UMデータシート」での「Finger 

Capacitance (CF) Based on Overlay Thickness and Circular Sensor Diameter」図および「Resolution Setting Based 

on Finger Capacitance and CP」表を参照して、分解能を 13に設定してください。 

6. Comparatorリファレンスを ASE11に設定します。  

ASE11は、大部分のアプリケーションに推奨されます。 

7. Scan速度を Normalに設定します。 
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表 8-3では、Bridge Control Panel で観察される、異なるセンサーのノイズ (指を触れない時の Rawカウントのば

らつき) および信号 (指を触れる時の応答) の値を列挙しています。 

表 8-3. 全センサーの信号 

センサー 

指を触れない時の

平均 rawカウン

ト  

信号 ノイズ 
SNR 

 (整数に丸めた値) 

BTN0 4451 179 20 9 

BTN1 3921 182 20 9 

BTN2 3419 184 21 9 

BTN3 3186 179 20 9 

BTN4 2652 191 21 9 

SLD0 3790 100 20 5 

SLD1 4432 101 20 5 

SLD2 4026 101 19 5 

SLD3 4011 103 19 5 

SLD4 3739 107 20 5 

SLD5 3456 104 20 5 

SLD6 3310 110 21 5 

SLD7 3158 99 19 5 

SLD8 2900 101 19 5 

SLD9 2688 115 20 5 

 

8. 全センサーの SNRは 5:1を超え、スキャン時間は指で押すと LEDが同時に光るほど低いため、表 8-4で説明してい

るようにしきい値のパラメーターを設定することができます。  

閾値を設定するには、全センサーの中で最も低い信号の値を基準として使用します。したがって、この例では、信号

の値は 99です。 

表 8-4. CSD UMの高級パラメーター 

閾値パラメーター 推奨値 値 UMパラメーター設定 

指の閾値 信号の 75% 75.3 74 

ノイズ閾値 信号の 40% 39.6 40 

ベースライン更新閾値 2ノイズ閾値 80 80 

マイナスのノイズ閾値 ノイズ閾値 40 40 

ヒステリシス 信号の 15% 14.9 15 

 

9. スキャン時間の要件を満たしており、誤検出がレポートされていないので、Low Baseline Resetパラメーターを 10

にセットします。Debounceを 3にセットします。 
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サンプルコード 9 CSA_EMCの調整 

(CY8C20x34 CapSenseコントローラー使用) 

 
 

 

9.1   プロジェクト名 

CE_9_TuningCSAEMC_withCY8C20x34 

9.2   概要 

このサンプルコードでは、CY8C20x34デバイスの CSA_EMCユーザーモジュール (UM）) を調整する方法を示します。

CapSense UM を調整するには、CapSense データをグラフ形式で表示できなければなりません。このサンプルコードで

は、EzI2C UMを使用して必要な CapSenseパラメーターを I2Cバスと I2C-USBブリッジを経由して転送します。PCで

ブリッジコントロールパネルを使用して、このデータを表示します。 

9.3   ハードウェアの準備 

9.3.1   関連ハードウェア 

▪ CY3280-20x34ユニバーサル CapSenseコントローラー ボード  

▪ CY3280-SLMユニバーサル CapSenseリニア スライダー モジュール 

▪ CY3240-I2USBブリッジまたは CY8CKIT-002 Miniprog3 

▪ CY3217-MiniProg1プログラマ キットまたは CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

▪ USBポート搭載 PC 

9.3.2   アセンブリ 

図 9-1 は、ハードウェアのセットアップを示します。CY3280-20x34 UCC キットを CY3280-SLM モジュールに

22x2_RA_Receptacle 経由で接続します。MiniProg1/Miniprog3 または I2USB ブリッジのどちらかを、キットの ISSP

ヘッダーに接続します。ハードウェア準備では、プログラミングに MiniProg1/Miniprog3 を使用し、PC にデータを送信

するには I2USBブリッジまたはMiniprog3を使用します。これらは、USBケーブルで PCに接続します。  

図 9-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-20x34 UCC

MiniProg1/MiniProg3

CY3240 I2USB/MiniProg3 

PC
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9.3.3   ボードの設定 

以下のハードウェアを接続します。 

▪ CY3280-SLM ドーターカードのヘッダーJ1 を CY3280-20x34UCC ボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ1 にジャンパーを嵌め、UCC ボードの VCCピンと 5 V をショートさせます。この設定により、ISSP コネ

クタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン(ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-SLMボードの GNDピンと SHILEDピン (ピン 2と 3) を接続させます。

この設定により、CY3280-SLMボード上のハッチパターンが接地されます。 

▪ MiniProg1/MiniProg3 を UCC ボードの J3 上の ISSP ヘッダーに接続します。この接続は、コードで生成される hex

ファイルで UCC をプログラミングするときのみ要求されます。この接続は、CapSense データが Bridge Control 

Panelソフトウェアで読み出される時、I2USBブリッジ/MiniProg3と置き換える必要があります。 

▪ USB A－ミニ Bケーブルを使用して、MiniProg1/Miniprog3 (または I2USBブリッジ) の他の端を接続します。 

9.4   回路図 

 

変調コンデンサ (CMOD) は、P0[3] に接続された 2.2nF のコンデンサです。560Ω の抵抗は、RF 干渉を軽減するため、 

各 CapSense ボタンに直列に接続されます。LED は 1kΩ の直列抵抗に接続しアクティブローの設定です。全部で、LED

が 5個、ボタンが 5個、セグメントが 10あるスライダが 1個あります。 
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表 9-1. LED、ボタン、スライダー セグメントのピン割り当て 

LED ボタン スライダー セグメント 

LED0 - P2[5] BTN0 - P1[6] SLD0 - P1[4]、SLD1 - P0[6] 

LED1 - P2[7] BTN1 - P1[3] SLD2 - P0[4]、SLD3 - P0[2] 

LED2 - P0[1] BTN2 - P3[3] SLD4 - P2[6]、SLD5 - P2[4] 

LED3 - P0[5] BTN3 - P2[1] SLD6 - P2[2]、SLD7 - P2[0] 

LED4 - P1[2] BTN4 - P2[3] SLD8 - P3[2]、SLD9 - P3[0] 

9.5   ソフトウェアの準備 

9.5.1   ツール 

▪ PSoC® Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

▪ Bridge Control Panel (ブリッジ コントロール パネル) 

9.5.2   ユーザーモジュール 

以下の表は、このコード表で使用されているユーザーモジュール 、および各ユーザーモジュールが占有するハードウェ

ア リソースを一覧にします。 

ユーザーモジュール ハードウェア リソース 

CSA_EMC CapSenseブロック 

EzI2C I2Cブロック 

9.5.3   ユーザーモジュール パラメーター、グローバルリソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバルリソースのリストが含まれています。  

注: サンプルコードは、CY3280-SLM キットに付属するアクリル製オーバーレイ (1.5mm) 向けに調整しました。オー

バーレイがこれより厚い場合は、このサンプルコードで説明しているプロジェクトを調整します。 

9.6   動作 

リセットすると、ファームウェアは以下の操作を実行します。 

▪ 構造体 MyI2C_Regs を定義し、ボタン番号、Raw カウント、差分カウント、ベースライン、セントロイド位置、所

定のボタン番号に対応する CapSenseボタンのステータスを保管します。 

▪ グローバル割り込みを有効にしてから、CSA_EMC UMを開始します。 

▪ EzI2Cのユーザーモジュールを開始し、構造体 MyI2C_Regsを I2C RAMバッファとして設定します。  

▪ 無限ループで以下の操作を実行します。 

 すべてのセンサーを継続的にスキャンし、構造体 MyI2C_Regs を Raw カウント、差分カウント、ベースライン、

スライダのセントロイド位置、および要求される CapSense ボタンで更新します。I2C マスターは、ボタン番号

を EzI2Cスレーブの I2Cバッファの最初のバイトに書き込み、特定のボタンの CapSenseを要求することができ

ます。 

 ファームウェアはボタンが押されるのを検出すると、対応する LED を点灯させます。ボタンを放すと、LED を

消灯させます。 

 スライダーに触れると、ファームウェアは LEDを点灯させて接触位置を示します。 
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図 9-2. サンプルコード 9の機能フローチャート 
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9.7   コードの実行 

ボードにサンプルプロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-20x34キットガイドの第 5章を参照してください。 

1. ボードを 5Vで給電するには、MiniProg1/Miniprog3または CY3280-20x34 UCCキットガイドで説明している電源の

いずれかを使用します。 

2. CY3280-SLMモジュール ボードでリニア スライダーに触れます。  

CY3280-SLMモジュール ボードの対応する LEDが点灯します。 

3. ボタンに触れます。  

CY3280-SLM モジュール ボードの対応する LED が点灯します。同時に複数のボタンが機能します。リニア スライ

ダーとボタンも同時に使用できます。 

9.8   I2Cを経由した CapSenseデータの読み出し 

この手順を使用してサンプルコードを実行し、CapSenseデータを Bridge Control Panelツールで読み出します。Bridge 

Control Panelツールの詳細については、「AN2397、“CapSense® Data Viewing Tools」を参照してください。 

1. I2USBブリッジ/MiniProg3と USB A－ミニ Bケーブルを使用して、コンピューターを CY3280-20x34ユニバーサル

CapSenseコントロール ボードの ISSPコネクタ J3に接続します。 

2. コンピューターのデスクトップで、Start > All Programs > Cypress > Bridge Control Panel (バージョン番号) > 

Bridge Control Panel (バージョン番号) を選択します。 

Bridge Control Panelは、PSoC Programmerのインストール中にインストールされるコンポーネントです。 

3. ポート選択ウィンドウからデバイスを選択します。 

4. CY3280-20X34 CapSenseコントローラー ボードに 5Vで電力を供給します。 

5. Bridge Control Panel で File > Open を選択します。サンプルコード プロジェクト フォルダに含まれる「BCP 

Configuration Files」フォルダから BCP.iicファイルを読み出します。  
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6. Charts > Variable Settingsを選択します。サンプルコード プロジェクト フォルダに含まれる「BCP Configuration 

Files」フォルダから BCP.ini ファイルを読み出します。OKをクリックして、メイン画面に戻ります。 

 

 

9.8.1   BTN0のローカウント、ベースライン、差分カウントの読み出し 

1. I2Cの書き込み命令W 04 00 00を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chartタブをクリックして、BTN0の rawカウント、ベースライン、差分カウントを表示します。 

9.8.2   SLD0の rawカウント、ベースライン、差分カウント、スライダー ポジションの読

み出し 

1. I2C書き込み命令W 04 00 05を一度送信します。 

2. Repeatボタンをクリックして、以下の I2C読み出し命令を継続的に送信します。 

 

R 04 @Sensor_Index @1RawCount @0RawCount @1Baseline @0Baseline @1DiffCount @0DiffCount 

@ButtonStatus @SliderPosition 

 

3. Chart タブをクリックして、SLD0 の Raw カウント、ベースライン、差分カウント、スライダー ポジションを表示

します。 
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9.9   CSA_EMCユーザーモジュールの調整 

このセクションでは、以下のフローチャートで概説されている手順を用いて、ユーザーモジュール パラメーターを調整

します。詳細については、CY8C20x34 CapSense design guideを参照してください。 

 

9.9.1   CSDユーザーモジュールの設定を行う 

PSoC Designerツールを使用して、CSD UMパラメーター設定を以下のように入力します。 

1. CPU_CLK を PSoC Designerツールのグローバル リソース ウィンドウにある SysClk/2と等しく設定します。設計

ニーズに合わせて、グローバル リソース ウィンドウの残りのパラメーターを設定します。 

2. 表 9-2では、サンプルコード 6: 絶対センサー静電容量の測定 (CY8C20x34 CapSenseコントローラー使用)で示される 

メソッドを使用して測定した各センサーの CPを一覧にします。この例の最大 CPは 15pFで、IMOは 12MHzである

ため、クロックを IMO/4に設定します。 

IMOの詳細については、CY8C20x34 CapSense Design Guideの表 15を参照してください。 
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表 9-2. すべてのセンサーの CP 

センサー ピン CP 

BTN0 P1[6] 15pF 

BTN1 P1[3] 13pF 

BTN2 P3[3] 12pF 

BTN3 P2[1] 11pF 

BTN4 P2[3] 9pF 

SLD0 P1[4] 14pF 

SLD1 P0[6] 14pF 

SLD2 P0[4] 13pF 

SLD3 P0[2] 12pF 

SLD4 P2[6] 12pF 

SLD5 P2[4] 11pF 

SLD6 P2[2] 10pF 

SLD7 P2[0] 10pF 

SLD8 P3[2] 10pF 

SLD9 P3[0] 9pF 

 

3. 整定時間のパラメーターを式を用いて計算します。 

 

Settling Time =  
5 × CINT

(Clock ×  CP  × 25 (
1

FCPU
))

 

CINT = 3.9nF  

クロック = IMO/4 = 3MHz  

CP = 15pF  

FCPU = SysClk/2 = 12MHz/2 = 6 MHz (この例では、SysClkは 12MHz に設定します) 

整定時間の上記の式で値を置き換えると、「Settling Time = 80」 

新しい設定を実行する場合、Bridge Control Panelツールを用いて SNRを測定します。表 9-3では、このサンプルコード

で見られる値を列挙します。 

表 9-3. 全センサーで観測される信号 

センサー番号 平均指を触れない時の Rawカウント ノイズ 信号 SNR (整数に丸めた値) 

BTN0 2000 14 130 9 

BTN1 2140 15 140 9 

BTN2 2210 18 140 8 

BTN3 2230 16 140 9 

BTN4 1930 20 150 7 

SLD0 1985 11 100 9 

SLD1 2310 14 95 7 

SLD2 2075 14 105 7 
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センサー番号 平均指を触れない時の Rawカウント ノイズ 信号 SNR (整数に丸めた値) 

SLD3 2160 13 95 7 

SLD4 2500 14 100 7 

SLD5 2370 15 105 7 

SLD6 2200 16 105 7 

SLD7 2180 14 110 8 

SLD8 1960 14 110 8 

SLD9 2050 15 110 7 

 

4. 最低 SNRは 7 (整数に四捨五入) で、5:1 より大きいため、高級パラメーターを表 9-4で説明されているように設定

します。 

表 9-4. UMの高級パラメーター 

閾値 推奨値 値 ユーザーモジュール パラメーター設定 

指の閾値 信号の 75% 71.25 71 

ノイズ閾値 信号の 40% 38 38 

ベースライン更新閾値 2* ノイズ閾値 76 76 

マイナスのノイズ閾値 ノイズ閾値 38 38 

ヒステリシス 信号の 15% 14.25 14 

 

5. 他のパラメーターは初期値のままにします。 
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サンプルコード 10 CY8C20xx6A の

SmartSenseによる CapSenseボタンの消費電

力の最適化 

 
 

 

10.1   プロジェクト名 

CE_10_PowerOptimization_withCY8C20xx6A 

10.2   概要 

このサンプルコードの目的は、SmartSense を使用するひとつのボタンの消費電流を 50µA 未満にすることにあります。

このサンプルコードは、SmartSenseと 16ビット タイマーのユーザーモジュールを組み込んでいます。このデバイスは、

一定期間スリープモードで動作して、平均消費電流を減らします。16 ビット タイマーは、スリープ時間経過後にデバイ

スを復帰させるために、スキャン タイマーとして使用します。 

10.3   ハードウェアの準備 

10.3.1   関連ハードウェア 

▪ CY3280-20x66ユニバーサル CapSenseコントローラー ボード  

▪ CY3280-BSMユニバーサル CapSenseシンプル ボタン モジュール 

▪ CY3217-MiniProg1プログラマ キットまたは CY8CKIT-002 Miniprog3 

▪ USB A－ミニ Bケーブル 

▪ 電流計 

▪ 電源 

10.3.2   組み立て 

図 10-1 はハードウェアの準備を示します。CY3280-20x66 UCC ユニットを CY3280-BSM モジュールに

22x2_RA_Receptacle 経由で接続します。この構成では、MiniProg1/MiniProg3 を使用してキットの ISSP ヘッダーに接

続してプログラミングします。 

図 10-1. ハードウェア セットアップのブロック図 

CY3280SLM CY3280-20x66 UCC MiniProg1/MiniProg3 PC

 

 

10.4   ボードの設定 

以下のハードウェアを接続します。 
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▪ CY3280-BSMドーターカードのヘッダーJ1を CY3280-20x66 UCCボード上の 22x2_RA_Receptacle (コネクタ P2) 

に接続します。 

▪ ヘッダーJ7 にジャンパーを嵌め、UCC ボードの VCC ピンと VCC_PROGピンを接続させます。この設定により、ISSP

コネクタから CapSenseコントローラーに電力を供給できます。 

▪ ヘッダーJ4にジャンパーを嵌め、UCCボードの XRESピンと XRES/INTピン(ピン 1と 2) を接続させます。この設

定では、CapSenseコントローラーの XRESピンが ISSPコネクタ J3のピン 3に接続されます。 

▪ ヘッダーJ2にジャンパーを嵌め、CY3280-BSMボードのピン GNDと SHILED (ピン 2と 3) を接続させます。この

設定により、CY3280-BSMボード上のハッチパターンが接地されます。 

▪ MiniProg1/MiniProg3を J3ヘッダー上の CY3280-20x66 UCCに接続します。 

10.5   回路図 

 

注: デバイスの電力消費量を測定しながら、CY3280-20x66 ユニバーサル CapSense Controllerから LED D1と D2を除

外します。SmartSense UM を備えたデバイスの消費電力は、システムの SNR により異なります。ボードレイアウトデ

ザインが CapSense入門ガイドのガイドラインに沿っている場合、消費電力は最小化されます。 

表 10-1.サンプルコード 10のピン割り当て 

コンポーネント ピン 

ボタン 0 P0[5] 

LED P0[1] 

CMOD P0[3] 
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10.6   ソフトウェアの準備 

10.6.1   ツール 

▪ PSoC® Designer (バージョン 5.2以降) 

▪ PSoC Programmer (バージョン 3.13以降) 

10.6.2   ユーザーモジュール 

以下の表は、このコード表で使用されているユーザーモジュール 、および各ユーザーモジュールが占有するハードウェ

ア リソースを一覧にします。 

ユーザーモジュール ハードウェア リソース ユーザーモジュール名 

SmartSense CapSenseブロック、タイマー1 (デフォルト) SmartSense 

タイマー16 タイマー0 Scan_Timer 

10.6.3   ユーザーモジュール パラメーター、グローバル リソース 

プロジェクトの ReadMe.txt ファイルでは、このサンプルコードで使用されるユーザーモジュールのパラメーター設定

について説明しています。また、グローバル リソースのリストが含まれています。  

10.7   動作 

リセットすると、プログラムはデバイス コンフィギュレーションからデバイスにすべてのハードウェア設定を読み出し、

main.cを実行します。ファームウェアは以下の動作を実行します。 

▪ SmartSense UM、ScanRate_Timer UM、LEDを初期化します。 

▪ グローバル割り込みを有効にしてから、SmartSenseと ScanRate_Timerユーザーモジュールを開始します。 

▪ ファームウェアはボタンが押されるのを検出すると、LED をオンに切り替えます。ボタンを放すと、LED を消灯さ

せます。この動作は、デバイスの機能を確認するために実行します。 

▪ デバイスがスリープモードに入っても、ファームウェアは継続的にセンサーをスキャンします。デバイスは、
ScanRate_Timer割り込みでスリープから復帰します。 

スキャン速度を変更するには、マクロ SCANRATE_TIMER_VALUE を変更します。これにより、ScanRate_Timer

の期間が制御されます。速度が遅くなるにつれて、応答が向上します。 
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図 10-2. サンプルコード 10の機能フローチャート 

Start

A. Enable global 

interrupts

B. Clear LED

Start SmartSense UM

Initialize CapSense 

baselines

Loop forever

Scan all sensors

Update all baselines

Check for active 

sensor

Update LED

Device wake up

Initialize Scan rate timer;

Set the PERIOD value to 

achieve desired current 

consumption

Stop SmartSense UM

Enter Sleep Mode

Resume SmartSense 

UM

 

 

10.8   コードの実行 

ボードにサンプル プロジェクトをプログラムしてから、この手順を使用してサンプルコードを実行します。UCC ボード

のプログラミングの方法については、CY3280-20x66キット ガイドの第 5章を参照してください。 

1. スキャン速度を変更するには、サンプルコードでマクロ SCANRATE_TIMER_VALUE を編集します。これにより、

ScanRate_Timer ユーザーモジュールのパラメーター期間が変更されます。スキャン速度は、関係式により変化しま

す。 

スキャン速度 = 周期 / 選択したクロック周波数 

ここで、周期 = SCANRATE_TIMER_VALUE 

2. 電流計を使用して、250、500、750、1000ms で異なるスキャン速度の電流を測定します。以下のグラフと表は、異

なる動作電圧の異なるスキャン速度における消費電力を示します。 

  

http://www.cypress.com/
http://www.cypress.com/?docID=29621


 CY8C20xx6A の SmartSenseによる CapSenseボタンの消費電力の最適化 

www.cypress.com  文書番号: 001-85884 Rev. *C 84 

図 10-3. 変化するスキャン速度と電圧における平均電流 

 

表 10-2. 変化するスキャン速度と電圧における平均電流 

スキャン速度 (ms) 平均電流 (µA) 

5V 3.3V 2.4V 1.8V 

1000 25.7 25.4 25.2 25.1 

750 29.5 29.1 28.8 28.7 

500 32.8 32.4 31.7 31.4 

250 40 39.6 39.1 39 
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付録 

 
 

 

CSDユーザーモジュールの設定 

この設計ガイドでプロジェクトを修正するには、PSoC® Designerソフトウェアで CapSenseユーザ－ モジュール (UM) 

を設定する必要があります。UM を設定すると、あるデバイスから他のデバイスにプロジェクトを移行することができま

す。すべての CapSense UM は、同じようなプロセスを使用して設定します。以下の例では、CSD の設定にソフトウェ

ア ウィザードを使用します。  

1. PSoC Designerの User Modulesウィンドウで、Cap Sensorsフォルダを展開します。 

 

2. Cap Sensorsフォルダで CSDを右クリックしてから、Placeを選択します。 
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Designerツールでは、チップ エディタの空きブロックにユーザーモジュールを配置します。 

 

3. 以下のスクリーン ショットに示すように、CSD_1プロパティを配置します。 
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4. CSDユーザーモジュールを右クリックしてから、CSD Wizardを選択します。 

ウィザードを使用して、ピンをセンサーに割り当てます。 

 

CapSenseウィザードが表示されます。 
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5. CSD Wizardウィンドウを使用して、Global Settingsを設定します。  

スクリーンショットの設定は、ボタンを 5個とスライダーを 1つ持つプロジェクトです。Global Settingsを使用し

て、プロジェクトに必要なセンサー数を設定します。 

 

6. CSD Wizard のスライダーをクリックすると、センサーの設定数が表示されます。以下の図のように、Sensor 

Settingsを設定します。 

 

7. 特定のピンにセンサーを割り当てるには、センサー ブロックからピン割り当てウィンドウにある必要なピンをク

リックしてドラックします。SW0をピン P1 [6]にドラッグ アンド ドロップします。センサーのピンの割り当ては、

テーブル ピン割り当て表示 (図 10-5) またはチップピン割り当て表示 (図 10-4) で行えます。 
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図 10-4. センサーをピンに割り当てる－チップピン割り当て 

 

図 10-5. センサーをピンに割り当てる－テーブル ピン割り当て 

 

8. 同様に、他のセンサーをデバイスのピンに割り当てることが可能です。OKをクリックして終了します。 
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他の CapSenseデバイスへのサンプルコードの移行 

エンド アプリケーションに適切なデバイスを選択するには、「Getting Started with CapSense Guide」を参照してくださ

い。本書に記載されているサンプルコードはすべて、表 1 にあるように、特定のデバイス向け (対象キット) です。サン

プルコードを他の CapSense デバイスで使用するには、プロジェクトをそのデバイスに移行 (または移植) する必要があ

ります。  

移行の前に、それぞれの CapSense デバイスでサポートされている CapSense ユーザーモジュールを理解します。

「Getting Started with CapSense Guide」の表 5-1 で、CapSense 製品ファミリをサポートする CapSense ユーザーモ

ジュールの対応表を示しています。 

以下のセクションでは、あるデバイスから別のデバイスにプロジェクトを移植する手順を順を追って説明します。  

SmartSense 

SmartSense UM は、CY8C20xx6A および CY8C21x34B デバイスファミリでサポートされています。詳細については、

サンプルコード 1: SmartSense付きボタン スライダー (CY8C20xx6A CapSenseコントローラー)を参照してください。

現在、当社では CY8C21x34B 部品のキットを提供していませんが、ユーザー環境で SmartSense と CY8C21x34B デバ

イスを一緒に使用することが可能です。CY8C21x34Bのキットを希望する場合は、電子メールで capsense@cypress.com

へお問い合わせください。 

CapSenseコントローラーとの通信 

サンプルコード 2: I2Cによるホスト通信(CY8C20xx6A CapSenseコントローラー使用) およびサンプルコード 3: UART

によるデータ送信 (CY8C20xx6A CapSense コントローラー使用)では、CapSense コントローラーCY8C20xx6A とホス

ト プロセッサを結びつけるための I2C と UART プロトコルの使用を説明します。これらのプロジェクトを他の

CapSenseコントローラーに移動するのは簡単で、それほど修正を必要としません。 

サンプルコード 3を他のデバイスに移植 

1. 任意の対象デバイスで新プロジェクトを作成します。  

新プロジェクトを作成する手順は、それぞれの UCCキットガイドに記載されています。  

2. UART UMを CapSense UM (CSD、CSA、CSA_EMCまたは SmartSense) と配置します。  

3. 動作の信頼性を高めるために、CapSense UM を必要に応じてサンプルコード 7、サンプルコード 8、またはサンプ

ルコード 9に記載されている方法で調整します。この手順では、SmartSenseは必要ありません。 

4. 必要に応じて、CapSenseと UART ユーザーモジュールを設定します。  

UART UMについては、サンプルコード 3で使用したのと同じ設定を使用できます。 

5. Workspace Explorer で、既存の main.c ファイルを開きます。既存の main.c の内容をサンプルコード 3 プロジェク

トのmain.cファイルの内容と置き換えます。 

6. サンプルコード 3フォルダから、display.cファイルと display.hファイルをプロジェクト フォルダの保存場所に追加

します。 

7. 3.7   コード サンプルの実行に従って、プロジェクトを実行します。  

MultiChartツールでプロットしたデータを表示するには、「CapSenseデータを MultiChartでプロットする」を参照

してください。 

CY8C24x94デバイスで I2Cを使用 

I2C プロトコルは、本書に記載されているサンプルコードのチューニングでデータ転送に使用されます。特定のデバイス

で I2Cを使用するには、サンプルコード 7、サンプルコード 8、およびサンプルコード 9プロジェクトを参照してくださ

い。CY8C24x94デバイスで I2C通信を使用するには、以下の手順に従ってください。 

1. CY8C24x94を対象デバイスとして新しいプロジェクトを作成します。  

CY3280-24x94 UCCキットで新しいプロジェクトを作成するには、このキットのガイドを参照してください。 

2. I2Cユーザーモジュールと CSDユーザーモジュールをプロジェクトに配置します。 

3. 動作の信頼性を高めるために、サンプルコード 7に記載されている方法で CSDユーザーモジュールを調整します。 

4. 必要に応じて、CapSenseと I2Cユーザーモジュールを設定します。  

I2C UMについては、サンプルコード 2で使用したのと同じ設定を使用できます。 
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5. サンプルコード 2プロジェクトからmain.cファイル、display.cファイル、および display.hファイルをプロジェクト

に追加します。 

6. Workspace Explorer で、既存の main.c ファイルを開きます。既存の main.c の内容をサンプルコード 2 プロジェク

トのmain.cファイルのコンテンツと置き換えます。 

7. サンプルコード 2フォルダから、display.cファイルと display.hファイルをプロジェクト フォルダの保存場所に追加

します。 

8. 2.7  サンプルコードの実行に従って、プロジェクトを実行します。 

9. I2C を経由して CapSense データを表示するには、サンプルコード 1 プロジェクト フォルダの BCP コンフィギュ

レーション ファイル フォルダをプロジェクトの保存場所にコピーしてから、1.8  I2Cを経由した CapSenseデータ

の読み出しを完了します。 

絶対センサー静電容量測定 

「サンプルコード 4 － 絶対センサー静電容量の測定 (CY8C20xx6A CapSenseコントローラー使用)」、「サンプルコー

ド 5 － 絶対センサー静電容量の測定 (CY8C21x34/B CapSenseコントローラー使用)」、「サンプルコード 6 － 絶対セ

ンサー静電容量の測定  (CY8C20x34 CapSense コントローラー使用 )」は、CY8C20xx6A、CY8C21x34/B および

CY8C20x34 デバイスの絶対センサー静電容量を測定します。CSD UM のアーキテクチャの類似性のため、CY8C24x94

デバイスには CY8C21x34/Bのセンサー静電容量を計算する方法が使用されます。CY8C24x94の CSD UMに関する詳細

は、CY8C24x94の CSDデータシートを参照してください。  

サンプルコード 5を CY8C24x94 Deviceに移植 

1. CY8C24x94を対象デバイスとして新しいプロジェクトを作成します。  

CY3280-24x94 UCCキットで新しいプロジェクトを作成するには、このキットのガイドを参照してください。 

2. CSDと UART UMをプロジェクトに配置します。必要に応じて、UMを設定します。  

このプロジェクトについては、サンプルコード 5で使用したのと同じ設定を使用できます。 

3. Workspace Explorerで、既存の main.cファイルを開きます。既存の main.cの内容をサンプルコード 5プロジェクト

のmain.cファイルのコンテンツと置き換えます。 

4. 感度の計算方法については、CY8C21x34/B_Calculsensitivity.xls ファイルを参照してください。main.c ファイルの感

度を計算値と置き換えます。 

5. ハイパーターミナルに絶対静電容量を表示するには、6.7  サンプルコードの実行を行います。 

サンプルコード 7～9は CapSense UM の調整方法を説明していますが、これはプロジェクトで使用されている UM

とデバイスに固有であり、 他のデバイスでは使用できません。 

関連文書 

設計ガイド 

▪ CapSense入門 

▪ CY8C20xx6A CapSense設計ガイド 

▪ CY8C20x34 CapSense設計ガイド 

▪ CY8C21x34/B CapSense設計ガイド 

データシート 

▪ CSDデータシート 

▪ CSA_EMCデータシート 

▪ SmartSenseデータシート 

アプリケーションノート 

▪ AN2397 – CapSense Data Viewing Tools 
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http://www.cypress.com/?rID=3481
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キット ガイド 

▪ CY3280-20x66ユニバーサル CapSenseコントローラー キット ガイド 

▪ CY3280-20x34ユニバーサル CapSenseコントローラー キット ガイド 

▪ CY3280-21x34ユニバーサル CapSenseコントローラー キット ガイド 

略語 

略語 定義 

AN Application Note (アプリケーションノート) 

API Application Programming Interface (アプリケーション プログラミングインターフェース) 

BSM Simple Button Module (シンプル ボタン モジュール) 

CE Code Example (サンプルコード) 

COM Communication (通信) 

CSA CapSense Successive Approximation (CapSense逐次比較方式) 

CSD CapSense Sigma Delta (CapSenseシグマ デルタ方式) 

EMC Electromagnetic Compatibility (電磁環境適合性) 

PC Personal Computer (パーソナル コンピューター) 

SLM Linear Slider Module (リニアスライダー モジュール) 

UART Universal Asynchronous Receiver/Transmitter (ユニバーサル非同期レシーバ／トランスミッター) 

UM User Module (ユーザーモジュール) 

USB Universal Serial Bus (ユニバーサル シリアル バス) 
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改訂履歴 

版 ECN番号 発行日 変更者 変更内容 

** 3895943 01/31/2013 HZEN これは英語版 001-74590 Rev. *Aを翻訳した日本語版 001-85884 Rev. **です。 

*A 4722941 05/04/2015 HZEN これは英語版 001-74590 Rev. *Dを翻訳した日本語版 001-85884 Rev. *Aです。 

*B 5077313 01/08/2016 HZEN これは英語版 001-74590 Rev. *Eを翻訳した日本語版 001-85884 Rev. *Bです。 

*C 6498147 03/01/2019 SSAS これは英語版 001-74590 Rev. *Fを翻訳した日本語版 001-85884 Rev. *Cです。 
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